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COLORIMETER 

About light: 

Visible light (commonly referred to simply as light) is electromagnetic 

radiation that is visible to the human eye, and is responsible for the sense of sight. 

Visible light has a wavelength in the range of about 380 nanometres (nm), or 

380×10
−9

 m, to about 740 nanometres – between the invisible infrared, with longer 

wavelengths and the invisible ultraviolet, with shorter wavelengths. 

 

Electromagnetic spectrum 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/Electromagnetic_radiation
http://en.wikipedia.org/wiki/Electromagnetic_radiation
http://en.wikipedia.org/wiki/Visual_perception
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Visual_perception
http://en.wikipedia.org/wiki/Wavelength
http://en.wikipedia.org/wiki/Nanometre
http://en.wikipedia.org/wiki/Infrared_light
http://en.wikipedia.org/wiki/Ultraviolet_light
http://en.wikipedia.org/wiki/Electromagnetic_spectrum
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V   - Violet 

I  - Indigo 

B -  Blue 

G  - Green 

Y  - Yellow 

O  - Orange 

R -  Red 

 

Aim :- Working of Colorimeter 

A colorimeter is a device used in colorimetry.  

The method of estimation of conc of coloured solute in a solution by comparing its 

colour intensity with that of a standard solution containing a known conc of the 

same solute is known as colorimeter. 

Principle:- 

Visible light of same intensity and an identical wavelength is passed through both 

solutions. When white light is passed through a colored solution, some 

wavelengths are absorbed more than others. 

It obeys Lambert’s and Beer’s law, which states that the concentration of a solute 

is proportional to the absorbance. 

http://en.wikipedia.org/wiki/Colorimetry_(chemical_method)
http://en.wikipedia.org/wiki/Beer-Lambert_law
http://en.wikipedia.org/wiki/File:EM_spectrum.svg
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 Beer’s Law: 

According to Beer’s law when monochromatic light passes through the colored 

solution, the  

amount of light transmitted decreases exponentially with increase in concentration 

of the  

colored substance. 

It = Ioe
-KC

 

 Lambert’s Law 

According to Lambert’s law the amount of light transmitted decreases 

exponentially with  

increase in thickness of the colored solution.  

It = Ioe
-KT 

Therefore, together Beer-Lambert’s law is: 

It /Io = e
-KCT

 

where, 

It  =  intensity of transmitted light 

Io   =  intensity of incident light 

e  =  base of neutral logarithm 

K  =  a constant 

C  =  concentration 

T =  thickness of the solution 

 

( fig. Digital Colorimeter ) 
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The essential parts of a colorimeter are : 

This apparatus comprises of the following parts :- 

1) Light source usually tungsten. 

2) Filter (the device that selects the desired wavelength) 

3) Sample chamber or cuvette chamber (the transmitted light passes through 

compartment wherein the solution containing the colored solution are kept in 

cuvette, made of glass or disposable plastic) 

4) Detector (this is a photosensitive element that converts light into 

electrical signals) (The spectrophotometer also works on a similar principle 

except the fact that it has UV light) 

Procedure to operate:- 

1) Switch on the instrument at least 10 minutes before use to allow it to 

stabilize. 

2)Select the most appropriate filter for the analysis and insert it in the light 

path.  

3) Place the reagent blank solution (everything present in test cuvette except 

the component to be determined) in the clean and dry cuvette, then adjust the 

optical density    (OD) to zero or transmittance to 100. Put the OD knob on. 

4) Now transfer the blank solution to its test tube. 

5) Place the known sample in the cuvette and read the absorbance of the 

solution. Do the  same for all known concentrations and record the OD. 

6) Finally take the test solution in another cuvette and read the optical density. 

7) After use turn off the instrument, rins and dry the cuvette then place them in 

their desired boxes. 

 

Observations:- 

 

 

Results:- 
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Protein analysis 

Determination of protein concentration by biuret method.  

Principle:- The peptide bonds of the protein react with cupric copper (Cu2+) 

under alkaline condition to yield a purple / violet coloured complex, which shows 

an absorption maximum at 540 nm. 

 

 

Protein reference standard: BSA is used as a reference standard protein (10 

mg/mL). Weigh accurately 1 g of BSA and transfer it to a clean and dry 100 mL 

volumetric flask. Suspend the protein in 50 mL of distilled water. Dissolve the 
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protein by adding few drops of 10 N sodium hydroxide solution and make up the 

volume to 100 mL. 

 

Reagents:- Biuret  reagent: Dissolve 1.5 g of cupric sulphate in 250 mL distilled 

water. Separately, weigh and dissolve 6 g of sodium potassium tartrate in 250 mL 

of distilled water. Mix the cupric sulphate and tartrate solutions in a 1 L beaker. To 

this solution add 300 mL of 10% (w/v) sodium hydroxide solution, with constant 

stirring. Make up the volume to 1L with distilled water using a volumetric flask. 

Store the biuret reagent in a plastic container.  

Procedure  

(i) Take 12 test tubes. Mark one  test tube as B (Blank),ten test tubes as 

S1,S2,S3,S4,S5,S6,S7,S8,S9,S10 respectively (Standard 1 -10) , one test 

tube as T (Test) . 

(ii) Make additions as  follows:-- 

Sr. 

No. 

Standard 

protein 

(mL) 

Distilled 

water (ml) 

Conc. Of 

Casein (mg) 

Biuret 

reagent 

(ml) 

Absorbance 

at 540 nm 

1 Blank 1.0 -- 5.0  

2 0.1 0.9 1 5.0  

3 0.2 0.8 2 5.0  

4 0.3 0.7 3 5.0  

5 0.4 0.6 4 5.0  

6 0.5 0.5 5 5.0  

7 0.6 0.4 6 5.0  

8 0.7 0.3 7 5.0  

9 0.8 0.2 8 5.0  

10 0.9 0.1 9 5.0  

11 1.0 -- 10 5.0  

12 Test 1.0 ml -- ( to be 

determined ) 

5.0  
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           mix the contents.  

(ii)  After 30 min of incubation at room temperature, measure the violet  colour 

developed against the reagent blank at 540 nm in a photometer/colorimeter 

and record the absorbance. 

(iii) Construct a calibration curve on a graph paper, by plotting the protein 

concentration (1-10 mg of protein) on x- axis and absorbance at 540 nm on 

the y- axis. Compute the concentration of the protein in the sample  from 

the calibration curve. 

 Observation table: 

Sr. 

No. 

Standard 

protein 

(mL) 

Distilled 

water (ml) 

Conc. Of 

Casein (mg) 

Biuret 

reagent 

(ml) 

Absorbance 

at 540 nm 

1 Blank 1.0 -- 5.0  

2 0.1 0.9 1 5.0  

3 0.2 0.8 2 5.0  

4 0.3 0.7 3 5.0  

5 0.4 0.6 4 5.0  

6 0.5 0.5 5 5.0  

7 0.6 0.4 6 5.0  

8 0.7 0.3 7 5.0  

9 0.8 0.2 8 5.0  

10 0.9 0.1 9 5.0  

11 1.0 -- 10 5.0  

12 Test 1.0 ml -- 
( to be 

determined ) 

5.0  
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Result : in given sample protein concentration is found as ______mg/ml 

Workout : Estimate the protein content in egg-white (lien's egg) and report the  

  value of protein as g%. 
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Estimation of Glucose 

Glucose analysis was done by O-Toluidine method. For glucose analysis from 

sample, O-Toluidine reagent had been used.   

Procedure :--  

In each test tube, 5 ml of O-Toluidine reagent had been taken. In the test tube 

marked as blank, 0.1 ml of distilled water was added. In the test tube marked as 

standard, 0.1 ml of glucose working standard (1 ml. of stock standard in 9 ml 

benzoic acid saturated.) was added which was prepared from glucose stock 

standard (glucose 1 gm., benzoic acid 250 mg. in 100 ml of distilled water) and in 

test tubes mark as test, 0.1 ml of test sample were added from each sample tube. 

     All the test tubes then kept in boiling water bath exactly for 8 minutes. After 8 

min. all the test tubes were moved from water bath and kept in cold water in a 

beaker. Optical density were measured in 630 nm in UV spectrophotometer with 

blank set as zero. Calculations were done for percentage of glucose per 100 ml.  

 

Formula used to calculate the percentage of glucose in tissues: 

     Optical density of test/optical density of standard × 100 

 

 

 

 

 

 

 

 



12 
 

 

 

Estimation of Cholesterol 

     Cholesterol analysis was done by Liebermann Burchard method. For analysis of 

Cholesterol from tissues, glacial acetic acid aldehyde free was used. 

 In test tube marked as Blank, 6ml of glacial acetic acid had been added then 0.1 

ml of distilled water was added followed by 4 ml color reagent (10% FeCl3 0.5ml 

was taken in 50 ml measuring cylinder and volume was make up with H2SO4 to 

the mark ). 

     In test tube marked as standard, 5 ml of glacial acetic acid aldehyde free was 

taken. 1 ml of cholesterol working standard (10 ml of cholesterol stock standard in 

50ml glacial acetic acid extra pure) was added in test tube which was prepared 

from cholesterol stock standard(1mg cholesterol in 1 ml distilled water) followed 

by 4 ml of color reagent.   

     In test tubes marked with test, 5 ml of acetic acid aldehyde free was taken. 0.1 

ml of test sample were added from each sample tube followed by 4 ml of color 

reagent in each test tube. All the test tubes were allowed to cool at room 

temperature. Absorbance was measured in 630 nm in UV Spectrophotometer 

against the reagent Blank. Blank was set as zero. Calculations were done for 

percentage of cholesterol present per 100 ml. 

 

Formula used to calculate the percentage of cholesterol in tissues: 

      Optical density of test/optical density of standard × 0.2×100/0.1 
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ANIMAL CELL CULTURE TECHNIQUE: 

Introduction 

Cell culture has become one of the major tools used in life sciences today. This 

guide is designed to serve as a basic introduction to animal cell culture. It is 

appropriate for laboratory workers who are using it for the first time, as well as for 

those who interact with cell culture researchers and who want better understanding 

of the key concepts and terminology in this interesting and rapidly growing field. 

What is cell and tissue culture? 

Tissue culture is the general term removal of cells, tissues or organs from an 

animal or plant and their subsequent placement into an artificial environment 

conducive to growth. This environment usually consists of a suitable glass slide of 

plastic culture vessel containing a liquid or semi-solid medium that supplies the 

nutrients essential for survival and growth. The culture of whole organs or intact 

organ fragments with the intent of studying their continued function or 

development is called organ culture. When the cells are removed from the organ 

fragments prior to, or during cultivation, thus disrupting their normal relationship 

with neighboring cells, it is called Cell Culture. 

Primary Culture: 

When cells are surgically removed from an organism and placed into a suitable 

culture environment, they will attach, divide and grow. This is called Primary 

Culture. 

Secondary Culture (a subculture derived from a primary culture) 

When the cells in the primary culture vessel have grown and filled up all of the 

available culture substrate, they must be sub cultured to give them room for 

continued growth. This is usually done by removing them as gently as possible 

from the substrate. The cell suspension can then be subdivided and placed into new 

culture vessels, is called as Secondary Culture. An alternative to establishing 

cultures by primary culture is to buy established cell culture (secondary cell 

culture) from organizations such as ATCC, NCCS, Pune. 
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1. Determination of cell viability and cell count: 

Trypan blue staining is a simple way to evaluate cell membrane integrity and thus 

cell viability. The isolated and washed lymphocytes are checked for viability and 

cell count using a hemocytometer. The purpose is to determine the cell density of 

viable cells in the culture. The viable and non-viable cell density can be 

determined with the use of dye (Trypan Blue) exclusion assay. The viable or living 

cells do not dye while non-viable or dead cells do so because of disrupted cell 

membrane. Non-viable or dead cells do not have the metabolic capability to expel 

the intruding dye.  

Material required: 

Reagents:  

1. Trypan blue dye solution (0.5%) 

2. Phosphate buffered saline 

3. RPMI-1640 medium 

Apparatus: 

1. Eppendorf tubes 

2. Micropipette and tips 

Equipments: 

1. Light microscope 

2. Hemocytometer with coverslip 

Method: 

1. Take 50µl of washed cell suspension in microcentrifuge tube. 

2. Add 400µl PBS and 10 µl of Trypan Blue solution to the cell suspension and 

mix thoroughly. 

3. Trypan blue- cell suspension is transferred to a chamber of hemocytometer 

with cover slip using a micropipette. It was done carefully by touching the 

edge of the cover slip with pipette tip and allowing the chamber to fill by 

capillary action. Care was taken to neither overfill nor under fill the 

chamber. 
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4. Count all the viable cells (colorless opaque) in the four WBC counting 

chamber of hemocytometer under light microscope. Occasionally non-viable 

cells with blue stained nucleus were also observed. 

 

 

 

 

 

Calculation: 

Cell count/ml= Average cell count in four 

chambers x 10 (dilution factor) x 

10
4
(Constant) 

If average cell count is 50 then,  

Cell count/ml = 50 x10 x 10
4
= 5 x 

10
6
cells/ml. 
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Viability staining: 

1. Prepare a cell suspension of at least 10
6
cells/ml by trypsinizing (adherent 

cells) or centrifugation (suspension cells) and resuspension. 

2. Add 0.5 ml of 0.4% (w/v) trypan blue and 0.3 ml of PBS or HBSS to 0.1ml 

of cell suspension mix thoroughly, and let stand for 1-2 min. 

3. At least 10
6
 cells/mlare required for accurate counting. 

Note:Blue –stained cells are non-viable and unstained cells are viable. 

Viability % = No. of viable cells/Total no. Of cells X 100  
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Primary Culture: Culturing of Peripheral blood lymphocytes  

Isolation of Lymphocytes: 

Peripheral blood lymphocytes from heparinised blood were isolated by gradient 

centrifugation using HIMEDIA HISep LSM 1077. 

Density Gradient method: 

It is simple and rapid method for separation of lymphocytes from whole blood. In 

this method and anticoagulant-treated blood is layered on Hisep solution and 

centrifuged, resulting in layers of different cell types due to differential migration. 

The bottom layers of different cell types due to differential migration. The bottom 

layer contains erythrocytes, the layer above contains Hisep, then lymphocytes and 

platelets, and the top layer contains plasma. The lymphocytes sit between the 

plasma and Hisep solution due to their lower density compared to the pelleted 

erythrocytes. 

 
 
 

 
Figure . Differential migration following centrifugation results 
in the formation of several cell layers. Mononuclear cells 
(lymphocytes and monocytes) and platelets are contained in 
the banded plasma-LSM interphase due to their density, and 
the pellet that is formed contains mostly erythrocytes and 
granulocytes, which have migrated through the gradient to 
the bottom of the tube. Lymphocytes are recovered by 
aspirating the plasma layer and then removing the cells. 
Excess platelets, HiSep™ LSM 1077, and plasma can then be 
removed by cell washing with isotonic phosphate buffered 
saline. 

Materials required: 
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Reagents: 

1. HISep LSM 1077 

2. Phosphate buffered saline 

3. RPMI-1640 medium 

Glassware/ Apparatus: 

1. 15ml centrifuge tubes 

2. Eppendorf tubes 

3. Micropipette  and tips 

4. Centrifuge tube stand 

Equipments: 

1. Refrigerated/ cold centrifuge (REMI) 

2. Light microscope 

3. Biosafety cabinet 

Method: 

1. Take 2ml heparinised blood from a consenting volunteer and dilute in 4ml of 

RPMI-1640. 

2. Layer blood carefully over 2-3ml HISep LSM 1077in a centrifuge tube (care 

has to be taken not to disturb the Hisep below. So, add sample slowly by the 

walls). 

3. Centrifuge at 1000 rpm for 20-25 minutes. 

4. Aspirate upper plasma layer. 

5. Then take out the lymphocytes from the buffy coat and put it in another 

centrifuge tube (care should be taken not to take RBCs). 

6. Wash the lymphocytes twice with RPMI medium. 

7. Suspend the lymphocyte pellet in 1ml of RPMI medium and check the cells 

for viability and do the cell count by hemocytometer. 

3.  Passaging/ Sub culturing 

After seeding a cell in a culture dish it grows and multiplies in presence of the 

supplied culture medium, they cover the tissue culture dish, and there is decrease in 

the nutrient, accumulation of toxic metabolites. 
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Passaging is a process of diluting cell number in order to keep cells actively 

growing otherwise; the cells will become unhealthy and stop growing. 

Passaging of adherent cells: 

Since adherent cells grow in a single layer (called monolayer) attached to the tissue 

culture dish, it is required to detach it from the cell culture dish for Passaging. 

Trypsinization is a process in which adherent cells were detached from the cultured 

dish with the help of protease enzyme treatment which digest the extracellular 

matrix, and bring the cells in the form of the suspension culture. After getting the 

cell in the form of suspension culture it was passaged similar to suspension culture. 

Trypsinisation: 

1. Observe the culture under microscope for contamination if any and 

condition of the cells. (Passage only healthy cells). 

2. Aspirate the medium and discard. 

3. Wash cells with medium without serum twice.The volume of the medium 

should be approximately the same as the volume of medium used for 

culturing the cells.Repeat the step if necessary. 

4. Add enough TVPG or trypsin solution to cover the monolayer, and rock the 

flask/dish 4-5 times to coat the monolayer. 

5. Give another wash of TVPG or trypsin.  

6. Tighten the flask cap and observe under inverted microscope until cells 

detach. If cells have not dislodged, loosen the flask cap and return the 

flask/dish to the incubator for a few minutes. 

7. Once dislodged, resuspend the cells in growth medium containing serum. 

Use medium containing serum. Use medium containing the same percentage 

of serum as used for growing the cells. 

8. Gently pipette the cells up and down to disrupt cell clumps, count, and 

replate at desired density in fresh flask/dishes. 

 

IMPORTANT: 

Do not leave cells in trypsin or TPVG solution for extended periods of time. Do 

not force the cells to detach before they are ready to do so, or clumping may occur. 

Overly confluent cultures, senescent cells, and some cell lines may be difficult to 
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trypsinize. Increase the length of trypsin exposure should help to dislodge resistant 

cells. Some cell lines will resist this treatment and will produce cell clumps. Such 

cell clumps can be broken up by repeatedly pipetting the cells up and down in a 

syringe with a needle attached. This should be performed as gently as possible to 

avoid damaging the cells. If pipette too vigorously, the cells will become damaged. 

Ensure that pipetting does not create foam. The serum inactivates the trypsin 

activity. 

 

Size of 

flask 

Volume of TPVG or 

trypsin 

Volume of Medium 

T25 2ml 5ml 

T75 5ml 15ml 

T 150-180 10ml 30ml 

     

TPVG = 0.25% trypsin, 0.02% EDTA, 0.1% glucose in phosphate buffered saline. 

Sub culturing suspension cell lines 

 

1. Observe the culture under microscope for contamination if any and 

condition of the cells. Passage only healthy cells. 

2. Gently pipette the cells and transfer to centrifuge tube and spin at 200Xg for 

10min. Aspirate the spent medium and discard. 

3. Gently pipette the cells up and down to disrupt cell clumps and count the 

cells. Collect the pellet and resuspend the cells in fresh complete medium at 

appropriate density and seed them in new flasks. 

4. Alternatively fresh medium can be added to obtain necessary cell density 

and cells are seeded in new flask. 

 

IMPORTANT: 

Cell clumps can be broken up by repeatedly pipetting the cell up and down in using 

wide bore pipette. This should be performed as gently as possible to avoid 

damaging the cells. If pipetted too vigorously, the cells will become dogged. 

Ensure that pipetting does not create foam. 

 

Adhered cells 
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1ml (0.25% Trypsin + 0.02% EDTA in phosphate buffer) 

 

Cell detachment 

 

Suspension culture 

 

Passaging
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4. Preparation of primary chick Embryo Fibroblast cultures 

1. For primary chick embryo cell cultures select embryos from 9 to 11 

day-old fertilized eggs derived from specific-pathogen-free flocks. 

Mark the air space. 

2. Swab to disinfect the egg with 70% ethanol or tincture iodine. 

3. Place the egg on rack with the air sac and uppermost. 

4. With gentle but firm strokes with sterile scalpel or sterile blunt thumb 

forceps break open the shell over the air sac end. 

5. Remove the egg shell membrane with sterile forceps. 

6. Lift out the embryo by holding the neck with forceps and place it in a 

sterile disposable Petridish with sterile balance salt solution. 

7. Wash the embryo with excess of BSS at least three times. 

8. Remove the heads, legs and wing tips of the embryos with sterile 

scissors. 

9. Wash the embryos in BSS. 

10. Open the body cavity of each embryo with the sterile forceps and 

remove the liver and the bulk of the other viscera. 

11. Gently squeeze the remainder of the embryo with the forceps to remove 

as much blood as possible. 

12. Pick the washed embryos out of the wash solution with the forceps. 

Drain them momentarily, and place them in a sterile, dry Petridish. 

Mince the embryos thoroughly by cutting with sharp, sterile scissors. 

13. Place the minced tissue in a 250ml sterile trypsinizing flask. Add 30 ml 

of 0.20% trypsin solution (prewarmed to approximately 350C), and 

trypsinize for 5 min at room temperature. 
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14. Carefully decant the supernatant suspension and discard. To the 

remaining fragments in the trypsinizing flask, add 70 ml of 0.20% 

trypsin and trypsinize for another 40 min. 

15. Allow big fragments to settle and transfer to the centrifuge bottle to 

stop the action of the trypsin on the cells. 

16. Centrifuge at approximately 250 x g for 10 minutes andcarefully 

remove the supernatant fluids. 

17. Resuspend the cells in growth medium to a concentration of 

approximately 800,000 cells per ml. 

18. Seed 1 ml per tube or 5ml per flask and incubate at 37
0
C.  
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5. Chromosome Preparation 

1. Seed the cells in flask and culture for 48 hours. 

2. Treat cells with colchicines (0.5 ug per ml) and incubate at 37
0
C for 2 

hours. Observe the cells, they will be rounded off and may be floating, 

if not, continue to incubate and check every half hour.  

3. Shake the bottle to dislodge the colchicines arrested metaphase cells 

and collect them along with the medium. 

4. Trypsinize the remaining cells in bottle and spin at 1000 rpm for 

5minutes. 

5. Discard the supernatant and resuspend the cell pellet in 5 ml of 

0.5%KCL and keep at 37
0
C for20 minutes to well the cells. 

6. Centrifuge at 1000 rpm for 10 min. Aspirate and discard all but 0.3 ml 

of supernatant. Mix by hand to break up the cell pellet. It is important to 

get the cell pellet completely resuspended, but the cells are fragile and 

easily broken. 

7. Slowly add 2ml of fixative (chilled Methanol + Acetic acid: 3+1 

volume) letting it run down the side of the tube so that it layers on top 

of the cell suspension. Cap the tube. Mix rapidly by hand so that all the 

cell suspension is fixed evenly; if it is mixed too slowly, clumps may 

form. Incubate at 40
0
 C for 15-20 minutes. 
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MOLECULAR TECHNIQUES: 

I. Isolation of Deoxyribose Nucleic Acid (DNA) 

 

Introduction 

Extraction and purification of nucleic acids is the first step in most molecular 

biology studies and in all recombinant DNA techniques. Here the objective of 

nucleic acid extraction methods is to obtain purified nucleic acids from various 

sources with the aim of conducting a GM specific analysis using the Polymerase 

Chain Reaction (PCR). Quality and purity of nucleic acids are some of the most 

critical factors for PCR analysis. In order to obtain highly purified nucleic acids 

free from inhibiting contaminants, suitable extraction methods should be applied. 

The possible contaminants that could inhibit the performance of the PCR analysis 

are listed in Table 1. In order to avoid the arising of a false negative result due to 

the presence of PCR inhibitors in the sample, it is highly recommended to perform 

a control experiment to test PCR inhibition. For this purpose, a plant-specific 

(eukaryote or chloroplast) or species-specific PCR analysis is commonly used. 

 

Table 1:Some inhibitors of the PCR process Inhibitor Inhibiting concentration 

 

INHIBITOR INHIBITING 

CONCENTRATION 

SDS > 0.005% 

Phenol > 0.2% 

Ethanol > 1% 

Isopropanol > 1% 

Sodium acetate > 5 mM 

Sodium chloride > 25 mM 

EDTA > 0.5 mM 

Hemoglobin > 1 mg/ml 

Heparin > 0.15 i.u./ml 

Urea > 20 mM 
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Reaction mixture > 15% 

As a wide variety of methods exist for extraction and purification of nucleic acids, 

the choice of the most suitable technique is generally based on the following 

criteria: 

 

• Target nucleic acid 

• Source organism 

• Starting material (tissue, leaf, seed, processed material, etc.) 

• Desired results (yield, purity, purification time required, etc.) 

• Downstream application (PCR, cloning, labelling, blotting, RT-PCR, cDNA 

synthesis, etc.) 

Extraction methods 

The principles of some of the most common methodologies used today for the 

extraction and purification of nucleic acids are described in the following sections.  

The extraction of nucleic acids from biological material requires cell lysis, 

inactivation of cellular nucleases and separation of the desired nucleic acid from 

cellular debris. Often, the ideal lysis procedure is a compromise of techniques and 

must be rigorous enough to disrupt the complex starting material (e.g. tissue), yet 

gentle enough to preserve the target nucleic acid. 

Common lysis procedures include: 

• Mechanical disruption (e.g. grinding, hypotonic lysis) 

• Chemical treatment (e.g. detergent lysis, chaotropic agents, thiol reduction) 

• Enzymatic digestion (e.g. proteinase K) 

Cell membrane disruption and inactivation of intracellular nucleases may be 

combined. For instance, a single solution may contain detergents to solubilise cell 

membranes and strong chaotropic salts to inactivate intracellular enzymes. After 

cell lysis and nuclease inactivation, cellular debris may easily be removed by 

filtration or precipitation.  
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Purification methods 

Methods for purifying nucleic acids from cell extracts are usually combinations of 

two or more of the following techniques: 

• Extraction/precipitation 

• Chromatography 

• Centrifugation 

• Affinity separation 

A brief description of these techniques will be given in the following paragraphs. 

 

Extraction/Precipitation 

Solvent extraction is often used to eliminate contaminants from nucleic acids. For 

example, a combination of phenol and chloroform is frequently used to remove 

proteins. Precipitation with isopropanol or ethanol is generally used to concentrate 

nucleic acids. If the amount of target nucleic acid is low, an inert carrier (such as 

glycogen) can be added to the mixture to increase precipitation efficiency. Other 

precipitation methods of nucleic acids include selective precipitation using high 

concentrations of salt (“salting out”) or precipitation of proteins using changes in 

pH. 

 

Chromatography 

Chromatography methods may utilise different separation techniques such as gel 

filtration, ion exchange, selective adsorption, or affinity binding. Gel filtration 

exploits the molecular sieving properties of porous gel particles. A matrix with 

defined pore size allows smaller molecules to enter the pores by diffusion, whereas 

bigger molecules are excluded from the pores and eluted at the void volume. Thus, 

molecules are eluted in order of decreasing molecular size. Ion exchange 
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chromatography is another technique that utilises an electrostatic interaction 

between a target molecule and a functional group on the column matrix. Nucleic 

acids (highly negatively charged, linear polyanions) can be eluted from ion 

exchange columns with simple salt buffers. In adsorption chromatography, nucleic 

acids adsorb selectively onto silica or glass in the presence of certain salts (e. g. 

chaotropic salts), while other biological molecules do not. A low salt buffer or 

water can then elute the nucleic acids, producing a sample that may be used 

directly in downstream applications. 

 

Centrifugation 

Selective centrifugation is a powerful purification method. For example 

ultracentrifugation in self-forming CsCl gradients at high g-forces has long been 

used for plasmid purification. Frequently, centrifugation is combined with another 

method. An example of this is spin column chromatography that combines gel 

filtration and centrifugation to purify DNA or RNA from smaller contaminants 

(salts, nucleotides, etc.), for buffer exchange, or for size selection. Some 

procedures combine selective adsorption on a chromatographic matrix (see above 

paragraph “Chromatography”) with centrifugal elution to selectively purify one 

type of nucleic acid. 

 

Affinity separation 

In recent years, more and more purification methods have combined affinity 

immobilisation of nucleic acids with magnetic separation. For instance, poly(A) + 

mRNA may be bound to streptavidin-coated magnetic particles by biotin-

labelledoligo(dT) and the particle complex removed from the solution (and 

unbound contaminants) with a magnet. This solid phase technique simplifies 
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nucleic acid purification since it can replace several steps of centrifugation, organic 

extraction and phase separation with a single, rapid magnetic separation step. 

DNA extraction using Kit columns 

A costly however, an effective method of extracting high quality amplifiable 

genomic DNA from whole blood, urine, dried blood spot, buffy coat and tissue 

biopsy samples. Refrigerated samples and reagents from the kit are brought to 

room temperature before starting the procedure. Check the following equipments 

and reagents are ready: 

• Water bath at 56°C. 

• Buffer AE or dd.H2O for elution. 

• Buffer AWl, Buffer AW2, and QIAGEN Protease. 

• If a precipitate has formed in Buffer AL, dissolve by incubating at 70oC 

• All centrifugation steps should be carried out at room temperature 

Extraction Protocol 

Pipette 20μl of Protease into the bottom of a 1.5ml microcentrifuge tube. 

Add 200 μl of the sample to the microcentrifuge tube. 

Add 200μl buffer AL (lysis buffer) to the sample. Mix by pulse-vortexing for 15sec. 

Incubate at 56°C for 10 min. 

(DNA yield reaches a maximum after lysis for 10 min at 56°C, but longer 

incubation times will not have negative effect on DNA extraction) 

Briefly centrifuge the 1.5ml microfuge tube to remove drops from the inside of the lid. 
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Add 200μl of ethanol (96-100%) to the sample and mix again by pulse-vortexing. 

After mixing, briefly centrifuge the 1.5ml microfuge tube to remove drops from 

the inside of the lid  

Carefully transfer the mixture from the previous step to QIAamp spin column (in a 

2ml collection tube) without wetting the rim, close the cap, and centrifuge at 

6000xg (8000rpm) for 1 min. Place the QIAamp spin column in a clean 2 ml 

collection tube (provided), and discard the tube containing the filtrate. 

Carefully open the QIAamp spin column and add 500μl Buffer AW1 without 

wetting the rim. Close the cap and centrifuge at 6000xg (8000rpm) for 1min. 

Place the QIAamp spin column in a clean 2ml collection tube (provided), and 

discard the collection tube containing the filtrate. 

Carefully open the QIAamp spin column and add 500μl Buffer AW2 without 

wetting the rim. Close the cap and centrifuge at full speed (20,000xg; 

14000rpm) for 3 min. Continue with the next step that is optional to eliminate 

any chance of possible buffer AW2 carryover or directly go to step after that 

and continue. 

 (Optional): Place the QIAamp spin column in a new 2 ml collection tube (not 

provided) and discard the collection tube containing the filtrate. Centrifuge at full 

speed for 1min. 

Place the QIAamp spin column in a clean 1.5ml microfuge tube (not provided), 

and discard the collection tube containing the filtrate.  

Carefully open the QIAamp spin column and add 200μl Buffer AE or distilled 

water. Incubate at room temperature for 5min, and then centrifuge at 6000xg 

(8000rpm) for 1min 
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Quantification of DNA: 

1. The extracted DNA is now referred asstock DNA and isstored at -20
0
C.   

2. After  isolation of  DNA,  quantization  is  done by  diluting  10 l  of  stock  

DNA  in  990 l  of  MQW  in  fresh  eppendorf  tube  and  was  vortex  for  

½  minute.  

3. Using  a  UV - spectrophotometer  the  estimate  of  the  purity  of  DNA  

sample was   obtained  by  calculating  the  ratio  between  the  readings  at  

260 nm  and  280 nm .  A  ratio  of  OD260/280  of  1.8  indicates  that  the  

preparation  is  pure.  

Table showing Example for OD ratio. 

Sample A/260 A/280 A260/280 A260 X 5 = x 1/x MQW 

10 BL 0.111 0.065 1.7 0.55 1.8 98.2 

 

By  diluting  1.8 l  of  stock  genomic  DNA  in  98.2  l  of  MQW  make  

the  quantity  10ng/ l. (A= Absorbance). Using this method, the all genomic 

DNAs were diluted and working stock was prepared for PCR amplification. 
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II. Agarose Gel Electrophoresis 

Introduction  
 

Electrophoresis through agarose or polyacrylamide gels lies near the heart of 

molecular biology and is used to separate, identify, and purify DNA fragments. 

The technique is simple, rapid to perform, and capable of resolving fragments of 

DNA that cannot be separated adequately by other procedures, such as density 

gradient centrifugation. 

Gel electrophoresis is a method that separates macromolecules on the basis of size, 

electric charge and other physical properties. The term electrophoresis describes 

the migration of charged particles under the influence of an electric field. “Electro” 

refers to electricity and “Phoresis”, from the Greek word phoros, meaning, "to 

carry across." Thus, gel electrophoresis refers to a technique in which molecules 

are forced across a span of gel, motivated by an electrical current. 

The driving force for electrophoresis is the voltage applied to electrodes at either 

end of the gel. The properties of a molecule determine how rapidly an electric field 

can move it through a gelatinous medium. 

Many important biological macromolecules (e.g. amino acids, peptides, proteins, 

nucleotides and nucleic acids) possess ionisable groups and, at any given pH, exist 

in solution as electrically charged species either as cations (+) or anions (-). 

Depending on the nature of the net charge, the charged particles will migrate either 

to the cathode or to the anode. For example, when an electric field is applied across 

a gel at neutral pH, the negatively charged phosphate groups of the DNA cause it 

to migrate toward the anode. 

Electrophoresis through agarose is a standard method used to separate, identify and 

purify DNA fragments. The technique is simple, rapid to perform, and capable of 
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resolving fragments of DNA that cannot be separated adequately by other 

procedures. Furthermore, the location of DNA within the gel can be determined by 

staining with a low concentration of ethidium bromide, a fluorescent intercalating 

dye. 

The following sections will outline the physical principles, components (gel 

matrix, buffer, loading buffer and marker) and procedures for the preparation of 

agarose gel electrophoresis (Sambrook et al., 1989). 

Physical principles of agarose gel electrophoresis 

Gel electrophoresis is a technique used for the separation of nucleic acids and 

proteins. Separation of macromolecules depends upon two variables: charge and 

mass. When a biological sample, such as DNA, is mixed in a buffer solution and 

applied to a gel, these two variables act together. The electrical current from one 

electrode repels the molecules while the other electrode simultaneously attracts the 

molecules. 

The frictional force of the gel material acts as a "molecular sieve", separating the 

molecules by size. During electrophoresis, macromolecules are forced to move 

through the pores and their rate of migration through the electric field depends on 

the following: 

 the strength of the field  

 the size and shape of the molecules  

 the relative hydrophobicity of the samples  

 the ionic strength & temperature of the buffer in which the molecules are 

moving.  

To completely understand the separation of charged particles in gel 

electrophoresis, it is important to look at the simple equations relating to 
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electrophoresis. When a voltage is applied across the electrodes, a potential 

gradient, E, is generated and can be expressed by the equation: 

E = V/d (1) where V, measured in volts, is the applied voltage and d the distance in 

cm between the electrodes. 

When the potential gradient, E, is applied, a force, F, on a charged molecule is 

generated and is expressed by the equation: 

F = Eq (2) where q is the charge in coulombs bearing on the molecule. It is this 

force, measured in Newtons that drives a charged molecule towards an electrode. 

There is also a frictional resistance that slows down the movement of charged 

molecules. This frictional force is a function of: 

 the hydrodynamic size of the molecule  

 the shape of the molecule  

 the pore size of the medium in which electrophoresis is taking place  

 the viscosity of the buffer  

The velocity v of a charged molecule in an electric field is a function of the 

potential gradient, charge and frictional force of the molecule and can be expressed 

by the equation: 

v = Eq / f (3) where f is the frictional coefficient. 

The electrophoretic mobility, M, of an ion can then be defined by the ion’s velocity 

divided by the potential gradient: 

M = v / E (4) 

In addition, from equation (3) one can see that electrophoretic mobility M can be 

equivalently expressed as the charge of the molecule, q, divided by the frictional 

coefficient, f: 

M = q / f (5) 

When a potential difference is applied, molecules with different overall charges 

will begin to separate due to their different electrophoretic mobilities. The 



35 
 

electrophoretic mobility is a significant and characteristic parameter of a charged 

molecule or particle and depends on the pK value of the charged group and the size 

of the molecule or particle. Even molecules with similar charges will begin to 

separate if they have different molecular sizes, since they will experience different 

frictional forces. 

Linear double stranded DNA migrates through gel matrices at rates that are 

inversely proportional to the log10 of the number of base pairs. Larger molecules 

migrate more slowly because of the greater frictional drag and because of the less 

efficient movement through the pores of the gel. 

The current in the solution between the electrodes is conducted mainly by the 

buffer ions with a small proportion being conducted by the sample ions. The 

relationship between current I, voltage V, and resistance R is expressed as in 

Ohm’s law: 

R = V / I (6) 

This equation demonstrates that for a given resistance R, it is possible to accelerate 

an electrophoretic separation by increasing the applied voltage V, which would 

result in a corresponding increase in the current flow I. The distance migrated will 

be proportional to both current and time. However, the increase in voltage, V, and 

the corresponding increase in current, I, would cause one of the major problems for 

most forms of electrophoresis, namely the generation of heat. This can be 

illustrated by the followingequation in which the power, W, (measured in Watts) 

generated during the electrophoresis is equal to the product of the resistance times 

the square of the current: 

W = I2R (7) 

Since most of the power produced in the electrophoretic process is dissipated as 

heat the following detrimental effects can result: 
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 an increased rate of diffusion of sample and buffer ions leading to 

broadening of the separated samples  

 the formation of convection currents, which leads to mixing of separated 

samples;  

 thermal instability of samples that are rather sensitive to heat (e.g. 

denaturation of DNA)  

 a decrease of buffer viscosity hence a reduction in the resistance of the 

medium  

 

Components of agarose gel electrophoresis 

Agarose 

Agarose, a natural colloid extracted from seaweed, is a linear polysaccharide 

(average molecular mass ~12,000 Da) made up of the basic repeated unit 

agarobiose, which comprises alternating units of galactose and 3, 6-

anhydrogalactose. 

Agarose is very fragile and easily destroyed by handling. Agarose gels have large 

"pore" sizes and are used primarily to separate large molecules with a molecular 

mass greater than 200 kDa. 

Agarose gels process quickly, but with limited resolution since the bands formed in 

the agarose gels tend to be fuzzy/diffuse and spread apart. This is a result of pore 

size and cannot be controlled. Agarose gels are obtained by suspending dry 

powdered agarose in an aqueous buffer, then boiling the mixture until the agarose 

melts into a clear solution. The solution is then poured onto a gel-tray and allowed 

to cool to room temperature to form a rigid gel. Upon hardening, the agarose forms 

a matrix whose density is determined by its concentration. 

Electrophoresis buffer 
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The electrophoretic mobility of DNA is affected by the composition and ionic 

strength of the electrophoresis buffer. In the absence of ions, electrical conductance 

is minimal and DNA migrates slowly, if at all. In a buffer of high ionic strength 

electrical conductance is very efficient and a significant amount of heat is 

generated. In the worst circumstance, the gel melts and the DNA denatures. 

Several buffers are available for electrophoresis of native double-stranded DNA. 

These contain EDTA (pH 8.0) and Tris-acetate (TAE), Tris-borate (TBE), or 

Trisphosphate (TPE) at a concentration of approximately 50 mM (pH 7.5 - 7.8). 

Electrophoresis buffers are usually prepared as concentrated solutions and stored at 

room temperature. TBE was originally used at a working strength of 1x for agarose 

gel electrophoresis. However, a working solution of 0.5x provides more than 

enough buffering power and almost all agarose gel electrophoresis is now carried 

out using this buffer concentration. 

Agarose concentration 

A DNA fragment of a given size migrates at different rates through gels depending 

on the concentration of agarose. For a specific concentration of agarose and/or 

buffer, it is possible to separate DNA segments containing between 20 and 50,000 

bp. In horizontal gels, agarose is usually used at concentrations between 0.7% and 

3% (see Table 1). 

 

Table 1. Recommended agarose gel concentration for resolving linear DNA 

molecules 

% agarose DNA size range (bp) 

0.75 10.000 - 15.000 

1.0 500 - 10.000 

1.25 300 - 5000 
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1.5 200 - 4000 

2.0 100 - 2500 

2.5 50 - 1000 

 

DNA Ladders and Markers 

DNA ladders and markers are available for sizing double-stranded, single-stranded, 

or supercoiled DNA. A variety of these DNA ladders and markers are also 

available in the ready-to-load format. 

1 Kb plus DNA Ladders 

The 1 Kb plus DNA Ladder is a powerful tool for estimating the molecular weight 

of linear double-stranded DNA fragments. The 1 Kb Plus DNA Ladder has 12 

evenly spaced bands ranging from 1 kb to 12 kb, a quick orientation band at 1,650 

bp that forms a distinct doublet with the 2 kb band, and seven bands of round-

number sizes below 1 kb. This wide size range is perfect for downstream cloning 

applications as well as PCR and other molecular biology applications. 

1 Kb plus Compatibility 

The 1 Kb Plus DNA Ladder is compatible with all agarose gels for DNA fragment 

analysis. The ladder is provided in a purified format without premixed loading 

buffer. 

Easy-to-remember band sizes  

Broad size range (100 bp–12 kb)  

Room temperature–stable for easy storage  
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The 1 Kb Plus DNA Ladder can be visualized with DNA stains such as SYBR® 

Safe stain, ethidium bromide, or similar DNA stains. In addition, the 1 Kb Plus 

DNA Ladder can be radiolabeled using T4 polynucleotide kinase, T4 DNA 

polymerase, DNA polymerase I, or Klenow fragment, and any radiolabeled dNTP. 

100 bp DNA Ladders 

The 100 bp DNA Ladder is suitable for sizing double-stranded DNA from 100 to 

1,500 bp. Prepared from a plasmid containing repeats of a 100 bp DNA sequence, 

the ladder consists of 15 blunt-ended fragments ranging in length from 100 to 

1,500 bp, in 100 bp increments, and an additional fragment at 2,072 bp. This ladder 

is ideal for determining the size of PCR products. 

DNA Stains 

There are several different stains that can be used to visualize and photograph 

DNA after separation by gel electrophoresis. The following list explains some of 

the choices of stains, and the differences between them. 

Molecular Probes® fluorescent nucleic acid gel stains—SYBR® Gold, SYBR® 

Green I, SYBR® Green II, and SYBR® Safe dyes—are highly sensitive reagents 

for staining DNA in electrophoresis gels. These gel stains provide greater 

sensitivity, with lower background fluorescence, than the conventional ethidium 

bromide gel stain. 

Ethidium Bromide (EtBr) Dye for DNA and RNA Detection 

Ethidium bromide is the most commonly used dye for DNA and RNA detection in 

gels. Ethidium bromide is a DNA intercalator, inserting itself between the base 

pairs in the double helix. Ethidium bromide has UV absorbance maxima at 300 and 
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360 nm, and an emission maximum at 590 nm. The detection limit of DNA bound 

to ethidium bromide is 0.5 to 5.0 ng/band. 

Structure, chemistry, fluorescence 

As with most fluorescent compounds, ethidium bromide is aromatic. Its core 

heterocyclic moiety is generically known as a phenanthridine, an isomer of which 

is the fluorescent dye acridine. The reason for ethidium bromide's intense 

fluorescence after binding with DNA is probably not due to rigid stabilization of 

the phenyl moiety, because the phenyl ring has been shown to project outside the 

intercalated bases. In fact, the phenyl group is found to be almost perpendicular to 

the plane of the ring system, as it rotates about its single bond to find a position 

where it will impinge upon the ring system minimally. Instead, the hydrophobic 

environment found between the base pairs is believed to be responsible. By 

moving into this hydrophobic environment and away from the solvent, the 

ethidiumcation is forced to shed any water molecules that were associated with it. 

As water is a highly efficient fluorescent quencher, the removal of these water 

molecules allows the ethidium to fluoresce. 

Applications 

Ethidium bromide is commonly used to detect nucleic acids in molecular biology 

laboratories. In the case of DNA this is usually double-stranded DNA from PCRs, 

restriction digests, etc. Single-stranded RNA can also be detected, since it usually 

folds back onto itself and thus provides local base pairing for the dye to intercalate. 

Detection typically involves a gel containing nucleic acids placed on or under a 

UV lamp. 
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Since ultraviolet light is harmful to eyes and skin, gels stained with ethidium 

bromide are usually viewed indirectly using an enclosed camera, with the 

fluorescent images recorded as photographs. Where direct viewing is needed, the 

viewer's eyes and exposed skin should be protected. In the laboratory the 

intercalating properties have long been used to minimize chromosomal 

condensation when a culture is exposed to mitotic arresting agents during harvest. 

The resulting slide preparations permit a higher degree of resolution, and thus more 

confidence in determining structural integrity of chromosomes upon microscopic 

analysis. Ethidium bromide has also been used extensively to reduce mitochondrial 

DNA copy number in proliferating cells. 

 

Loading buffer 

The DNA samples to be loaded onto the agarose gel are first mixed with a loading 

buffer usually comprising water, sucrose, and a dye (e.g. xylene cyanole, 

bromophenol blue, bromocresol green, etc.). The maximum amount of DNA that 

can be loaded depends on the number of fragments. The minimum amount of DNA 

that can be detected by photography of ethidium bromide stained gels is about 2 ng 

in a 0.5-cm wide band. 

If there is more than 500 ng of DNA in a band of this width, the slot will be 

overloaded, resulting in smearing. The loading buffer serves three purposes: 

 Increases the density of sample ensuring that the DNA drops evenly into the 

well 

 Adds colour to the sample, thereby simplifying the loading process  
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 Imparts a dye to the sample that, in an electric field, moves toward the anode 

at a predictable rate  

Experimental 

Caution:Ethidium bromide is a powerful mutagen/carcinogen and is moderately 

toxic. Gloves should always be worn when handling solutions and gels containing 

ethidium bromide. 

 

 

 

Equipment 

 Horizontal electrophoresis unit with power supply  

 Microwave oven or heating stirrer  

 Micropipettes  

 1.5 ml reaction tubes  

 Balance capable of 0.1 g measurements 

 Spatulas 

 Rack for reaction tubes 

 Glassware 

 Transilluminator (UV radiation, 312 nm) 

 Instruments for documentation (e.g. Polaroid camera or a video recorder)  

Reagents 
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 Agarose, suitable for DNA electrophoresis 

 Tris[hydroxymethyl] aminomethane (Tris) 

 Boric acid 

 Na2EDTA 

 Ethidium bromide 

 Sucrose 

 Xylene cyanole FF  

 DNA markers:  Lambda DNA EcoRI/HindIII digested (or other similar 

suitable marker) 

 100 bp DNA ladder  

 

10x TBE buffer (1 litre)  

Tris [hydroxymethyl] 

aminomethane (Tris) 

54.

0 g 

Boric acid 27.

5 g 

Na2EDTA 7.4

4 g 

 

• Mix reagent to deionised water to obtain a 1 litre solution at pH 8.3  

• Store at room temperature  

6x loading buffer (10 ml)  

Xylene cyanole FF 0.025 g 

Sucrose 4 g 

 Add sucrose and Xylene cyanole FF to deionised water to obtain 10 ml of 

solution.  

 Mix the solution, autoclave and store at 4°C. 

Loading of Agarose Gel 
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Prepare samples and marker for genomic DNA as follows: 

 sample marker 

 water                     
3 µl 

water                           6 µl 

 loading buffer         
2 µl 

loading buffer             2 µl 

 sample                     
5 µl 

λ DNA EcoRI / HindIII 2 µl 

 Total                         
10 µl 

Total                         10 µl 

Prepare samples and marker for PCR products as 
follows: 

 

sample  marker  
loading 
buffer 

2 µl 100 bp DNA 
ladder 

1
5 
µl 

sample 8 µl   

 10 µl   

Load 10 µl of each sample into consecutive wells and the appropriate DNA 

marker into the first and last lane 

 

 

Close the lid of the gel tank and attach the electrical leads so that the DNA 

will migrate toward the anode and apply a voltage of 5 - 10 V/cm 

 

 

Run the gel until the xylene cyanole has migrated the appropriate 

distance through the gel (~ 40 - 60 minutes) 
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Turn off the current; remove the leads and the lid from the gel tank. Place the 

gel on a UV lightbox and photograph the gel 

 

 

Discard the gel into the provided ethidium bromide solid waste bin 
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III. Polymerase Chain Reaction (PCR) – A Noble WinningTechnology 
 
 
 
Introduction:  
Polymerase Chain Reaction was developed in 1984 by the American biochemist, 

Kary Mullis. Kary Mullis received the Nobel Prize and the Japan Prize in 1993 for 

the development of this technology. However the basic principle of replicating a 

piece of DNA using two primers had already been described by Gobind Khorana 

in 1971. Progress was limited by primer synthesis and polymerase purification 

issues. 

 
PCR since then has become the most common and often indispensable technique 

used in medical and biological research labs for a variety of applications. It is an 

extremely powerful technique which rapidly became one of the most widely used 

techniques in molecular biology because it is quick, inexpensive and simple. 

 

The technique amplifies specific DNA fragments from minute quantities of source 

DNA material. As PCR is quick in generating unlimited copies of any fragment of 

DNA, it is a scientific development that actually deserves timeworn superlatives 

like “revolutionary” and “breakthrough”. Furthermore, many important 

contributions to the development and application of PCR technology have been 

made; however the present literature attempts to review and make you understand 

the basics of PCR. 
 
Principle:  
The basic PCR principle is simple. As the name implies, it is a chain reaction: One 

DNA moleculeis used to produce two copies, then four, then eight and so forth. 

This continuous doubling is accomplished by specific proteins known as 

polymerases, enzymes that are able to string together individual DNA building 

blocks to form long molecular strands. 

 
To do their job polymerases require a supply of DNA building blocks, i.e. the 

nucleotides consisting of the four bases adenine (A), thymine (T), cytosine (C) and 

guanine (G). They also need a small fragment of DNA, known as the primer, to 

which they attach the building blocks as well as a longer DNA molecule to serve as 

a template for constructing the new strand. If these three ingredients are supplied, 

the enzymes will construct exact copies of the templates. PCR is a method used to 
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acquire many copies of any particular strand of nucleic acids. It’s a means of 

selectively amplifying a particular segment of DNA. 

 
The segment may represent a small part of a large and complex mixture of DNAs 

e.g. a specific exon of a human gene. Therefore it can be thought of as a molecular 

photocopier (or molecular Xerox machine). 

 

PCR can amplify a usable amount of DNA (visible by gel electrophoresis) in ~2 

hours. The PCR product thus obtained can be digested with restriction enzymes, 

sequenced or cloned. PCR can amplify a single DNA molecule, e.g. from a single 

sperm. The polymerase chain reaction relies on the ability of DNA copying 

enzymes to remain stable at high temperatures. 

 
PCR has transformed the way that almost all studies requiring the manipulation of 

DNA fragments may be performed as a result of its simplicity and usefulness. 

Mullis's original PCR process was very inefficient since it required a great deal of 

time, vast amounts of DNA-Polymerase, and continual attention throughout the 

PCR process. Due to developments in the technology, it has shown to have wide 

utility for researchers interested in; 
 

o Forensic analysis – paternity.   
o Genetics – human, animals, plants and microbes.   
o monitoring of therapeutic treatments   
o Diagnostic applications, and for myriad of never ending research and 

clinical applications.  
 
Process: 

 

Typically, PCR consists of a series of 20-40 repeated temperature changes, called 

cycles, with each cycle commonly consisting of 2-3 discrete temperature steps, 

usually three (fig important). The cycling is often preceded by a single temperature 

step (called hold) at a high temperature (>90°C), and followed by one hold at the 

end for final product extension or brief storage. The temperatures used and the 

length of time they are applied in each cycle depend on a variety of parameters. 

These include the enzyme used for DNA synthesis, the concentration of divalent 

ions and dNTPs in the reaction, and the melting temperature (Tm) of the primers. 
 
Initialization step: 

 
 

This step consists of heating the reaction to a temperature of 94–96 °C (or 98 °C if 
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extremely thermostable polymerases are used), which is held for 1–9 minutes. It is 

only required for DNA polymerases that require heat activation by hot-start PCR. 
 

 

Denaturation step: 
 

 
This step is the first regular cycling event and consists of heating the reaction to 

94– 98 °C for 20–30 seconds. It causes DNA melting of the DNA template by 

disrupting the hydrogen bonds between complementary bases, yielding single-

stranded DNA molecules. 
 
Annealing step: 

 
 

The reaction temperature is lowered to 50–65 °C for 20–40 seconds allowing 

annealing of the primers to the single-stranded DNA template. Typically the 

annealing temperature is about 3-5 degrees Celsius below the Tm of the primers 

used. Stable DNA-DNA hydrogen bonds are only formed when the primer 

sequence very closely matches the template sequence. The polymerase binds to the 

primer-template hybrid and begins DNA formation. 
 

 

Extension/elongation step:   

The temperature at this step depends on the DNA polymerase used; Taq 

polymerase has its optimum activity temperature at 75–80 °C, and commonly a 

temperature of 72 °C is used with this enzyme. At this step the DNA polymerase 

synthesizes a new DNA strand complementary to the DNA template strand by 

adding dNTPs that are complementary to the template in 5′ to 3′ direction, 

condensing the 5′-phosphate group of the dNTPs with the 3′-hydroxyl group at the 

end of the nascent (extending) DNA strand. 
 

 

The extension time depends both on the DNA polymerase used and on the length 

of the DNA fragment to be amplified. As a rule-of-thumb, at its optimum 

temperature, the DNA polymerase will polymerize a thousand bases per minute. 

Under optimum conditions, i.e., if there are no limitations due to limiting 

substrates or reagents, at each extension step, the amount of DNA target is 

doubled, leading to exponential (geometric) amplification of the specific DNA 

fragment.  

 

 

http://en.wikipedia.org/wiki/Denaturation_(biochemistry)#Nucleic_acid_denaturation
http://en.wikipedia.org/wiki/Annealing_(biology)
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Final elongation: 
 

 

This single step is occasionally performed at a temperature of 70– 74 °C for 5–

15 minutes after the last PCR cycle to ensure that any remaining single-

stranded DNA is fully extended. 
 

 

Final hold: 
 

 
This step at 4–15 °C for an indefinitetime may be employed for short-termstorage 

of the reaction. 
 
Necessities of PCR Reaction:  
A basic PCR set up requires several components and reagents. These components 

include: 
 

 DNA template that contains the DNA region (target) to be amplified. 

 Two primersthat are complementary to the 3′(three prime) ends of each of 

the sense andanti-sense strand of the DNA target.  

 Taq polymerase or another DNA polymerasewith a temperature optimum at 

around 70 °C. 

 Deoxynucleoside triphosphates (dNTPs;  nucleotides containingtriphosphate 

http://en.wikipedia.org/wiki/Nucleotide
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groups), thebuilding-blocks from which the DNA polymerase synthesizes a 

new DNA strand. 

 Buffer solution,providing a suitable chemical environment for optimum 

activity andstability of the DNA polymerase. 

 Divalent cations,HYPERLINK  "http://en.wikipedia.org/wiki/Magnesium"  

magnesium or manganeseions; generally Mg2+is used, but Mn2+can 

beutilized for PCR-mediated DNA  mutagenesis, as higher 

Mn2+concentration increases the error rate during DNA synthesis  

 Monovalent cationpotassiumions. 

The PCR is commonly carried out in a reaction volume of 10–200 μl in small 

reaction tubes (0.2–0.5 ml volumes) in a  thermal cycler. The thermal cycler heats 

and cools the reaction tubes to achieve the temperatures required at each step of the 

reaction. 

 

Many modern thermal cyclers make use of the Peltier effect, which permits both 

heating and cooling of the block holding the PCR tubes simply by reversing the 

electric current. Thin-walled reaction tubes permit favourable thermal conductivity 

to allow for rapid thermal equilibration. Most thermal cyclers have heated lids to 

prevent condensation at the top of the reaction tube. Older thermal cyclers lacking 

a heated lid require a layer of oil on top of the reaction mixture or a ball of wax 

inside the tube. 
 
Variations on the basic PCR technique 
 

Touchdown PCR (Step-down PCR): 
 

 

A variant of PCR, aimed at reducing nonspecific background by gradually 

lowering the annealing temperature as PCR cycling progresses. The annealing 

temperature at the initial cycles is usually a few degrees (3-5°C) above the Tm 

of the primers used, while at the later cycles, it is a few degrees (3-5°C) below 

the primer Tm. 
 

 

The higher temperatures give greater specificity for primer binding, and the 

lower temperatures permit more efficient amplification from the specific 

http://en.wikipedia.org/wiki/Buffer_solution
http://en.wikipedia.org/wiki/Divalent
http://en.wikipedia.org/wiki/Divalent
http://en.wikipedia.org/wiki/Manganese
http://en.wikipedia.org/wiki/PCR_mutagenesis
http://en.wikipedia.org/wiki/Potassium
http://en.wikipedia.org/wiki/Thermal_cycler
http://en.wikipedia.org/wiki/Thermoelectric_cooling
http://en.wikipedia.org/wiki/Touchdown_PCR
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products formed during the initial cycles. 
 

 

Allele-specific PCR: 
 

 

A diagnostic or cloning technique based on single-nucleotide variations (SNV 

not to be confused with SNP) (single-base differences in a patient). It requires 

prior knowledge of a DNA sequence, including differences between alleles, and 

uses primers whose 3′ ends encompass the SNV (base pair buffer around SNV 

usually incorporated). 
 

 

PCR amplification under stringent conditions is much less efficient in the 

presence of a mismatch between template and primer, so successful 

amplification with an SNP-specific primer signals presence of the specific SNP 

in a sequence. 
 

 

Nested PCR: 
 

 

It increases the specificity of DNA amplification, by reducing background due 

to non-specific amplification of DNA. Two sets of primers are used in two 

successive PCRs. In the first reaction, one pair of primers is used to generate 

DNA products, which besides the intended target, may still consist of non-

specifically amplified DNA fragments. 
 

 

The product(s) are then used in a second PCR with a set of primers whose 

binding sites are completely or partially different from and located 3′ of each of 

the primers used in the first reaction. Nested PCR is often more successful in 

specifically amplifying long DNA fragments than conventional PCR, but it 

requires more detailed knowledge of the target sequences. 
 

 

Hot start PCR: 
 

 

A technique that reduces non-specific amplification during the initial set up 

stages of the PCR. It may be performed manually by heating the reaction 

components to the denaturation temperature (e.g., 95°C) before adding the 

polymerase. Specialized enzyme systems have been developed that inhibit the 

polymerase’s activity at ambient temperature, either by the binding of an  

antibody or by the presence of covalently bound inhibitors that dissociate only 

after a high-temperature activation step. 
 

 

Hot-start/cold-finish PCR is achieved with new hybrid polymerases that are 

http://en.wikipedia.org/w/index.php?title=Allele-specific_PCR&action=edit&redlink=1
http://en.wikipedia.org/wiki/Nested_PCR
http://en.wikipedia.org/wiki/Hot_start_PCR
http://en.wikipedia.org/wiki/Antibody
http://en.wikipedia.org/wiki/Antibody
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inactive at ambient temperature and are instantly activated at elongation 

temperature. 
 

 

Multiplex-PCR: 
 

 

It consists of multiple primer sets within a single PCR mixture to produce 

amplicons of varying sizes that are specific to different DNA sequences. By 

targeting multiple genes at once, additional information may be gained from a 

single test-run that otherwise would require several times the reagents and more 

time to perform. 
 

 

Annealing temperatures for each of the primer sets must be optimized to work 

correctly within a single reaction, and amplicon sizes. That is, their base pair 

length should be different enough to form distinct bands when visualized by  

gel electrophoresis. 
 

1. Polymerase Chain Reaction   

      
Sr 
no  Constituents Stock Volume added Final 

   concentration (µl) 
concentratio
n 

      

1  MilliQ - 13.8 - 
      

2  Buffer 10X 2.5 1X 
      

3  dNTP 10 mM 1.0 Variable 
      

4  Forward primer 10pmol/µl 1.0 10pmol/µl 
      

5  Reverse primer 10pmol/µl 1.0 10pmol/µl 
      

6  Taq polymerase 5U/µl 0.2 1U/µl 
      

7  DNA template 20ng 5.0 100ng 
      

   Total Volume  25 µl  
 
The above tabulation is the flow-sheet for preparation of the master mix for 

PCR reaction. The addition of the components must be in the order 

maintained in the table. 

http://en.wikipedia.org/wiki/Multiplex-PCR
http://en.wikipedia.org/wiki/Gel_electrophoresis
http://en.wikipedia.org/wiki/Gel_electrophoresis
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2.  Programming Thermal Cycler 
 

Process Temperature Time Cycle/Hold Repeat 
     

Initial 95°C 5min Hold Only once 
Denaturation     

     
Denaturation 95°C 30 sec Cycle  

     
Annealing 56°C 30 sec Cycle  

    35 times 
Extension 72°C 30 sec Cycle  

     
Final Extension 72°C 5min Hold Only Once 

     
 

The steps followed while preparing the program on thermal cycler will be 

different from machine to machine. A basic flow of events is presented in 

the table and in the flowchart. 
 

Set up the Initial Denaturation Temperature. 
 

 

Set up the time for denaturation process. 
 
 
 

Set up the hold for the Initial Denaturation Process. 
 
 
 

Set up the number of cycle s of the process. 
 
 
 

Set up the time for denaturation process within the cycle. 
 
 
 

Set up the time duration for annealing process within the cycle. 
 
 
 

Set up the time duration for extension process within the cycle. 
 

 

Set up the time duration and Hold duration for Final Extension process.  
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IV. Restriction Fragment Length Polymorphism (RFLP) –Biological 

 Scissors 

 

Restriction enzymes also known as restriction endonucleases (REases) are the 

basic tools of molecular biology. They are enzymes that cleave double-stranded 

deoxyribonucleic acids (DNAs) in a sequence-specific manner and are 

ubiquitously present among prokaryotic organisms. They form part of the 

restriction-modification systems, which usually consist of an endonuclease and a 

methyltransferase. Restriction endonucleases have been the workhorse of 

molecular biology for the past 30 years. 

 

They catalyse the breakage of phosphodiester bonds on DNA backbones at specific 

sites and, together with their companion methyltransferases, are part of bacterial 

defence systems against the invasion of bacteriophages. Their working principle as 

well as their applications since their discovery has greatly impacted and enhanced 

genetic engineering which this review article hopes to elaborate. 

 
Basics of Restriction Enzymes 

 

Restriction endonucleases degrade foreign DNA upon its introduction into a cell. 

These enzymes recognize particular base sequences, called recognition 

sequencesorrecognitionsites,in their target DNA and cleave that DNA at defined 

positions. Once inside a bacterialhost, the restriction enzymes selectively cut up 

foreign DNA in a process called restriction. To cut the DNA, a restriction enzyme 

makes two incisions, once through each sugar-phosphate backbone (i.e. each 

strand) of the DNA double helix. The restriction endonucleases catalyse the 

breakage of the phosphodiester bonds on DNA backbones at specific sites and, 

together with their companion methyl transferases, are part of bacterial defence 

systems against the invasion of bacteriophages. 

 

The most well studied class of restriction enzyme comprises of the so adenosine 

triphosphate (ATP) hydrolysis-dependent, translocation of double-stranded DNA 

towards the stationary enzyme bound at the recognition sequence. Following 

restriction, the enzymes are thought to remain associated with the DNA at the 

target site, hydrolyzing copious amounts of ATP. 
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Typically ~1520 hydrogen bonds are formed between a dimeric restriction enzyme 

and the bases of the recognition sequence, in addition to numerous van der Waals 

contacts to the bases and hydrogen bonds to the backbone, which may also be 

water mediated. The recognition process triggers large conformational changes of 

the enzyme and the DNA, which lead to the activation of the catalytic centres. In 

many restriction enzymes the catalytic centres, one in each subunit, in which the 

two carboxylates are responsible for Mg2+ binding, the essential cofactor for the 

great majority of enzymes. Cleavage in the two strands usually occurs in a 

concerted fashion and leads to inversion of configuration at the phosphorus. The 

products of the reaction are DNA fragments with a 3'-OH and a 5'-phosphate. 

 

Classification of Restriction Enzymes:  
RestrictionModification (R-M) enzymes are classified into three main groups 

designated types I, II & III; based on their subunit structure, cofactor 

requirements, sequence recognition andcleavage position. 

 

Type II systems are the most well known, having found widespread use in 

molecular cloning.They comprise separate methylases and homodimeric restriction 

endonucleases which recognize short, usually palindromic sequences of 4-8 

basepairs (bp) in the presence of Mg2+ and cleave the DNA within or in close 

proximity to the recognition sequence. Cleavage is catalytic and typically occurs 

either within, or immediately adjacent to the palindromic sequence. 

Type III RM enzymes are tetramericholoenzymes that possess sequence-

specificmethylation, restriction and DNA dependent nucleoside triphosphatase 

activities. The sequence recognized is 56bp in length and cleavage typically occur 

2527bp away from, and to one side of the recognition sequence. 

Type I are the most complex of the group,the first R-M systems discovered. Type I 

restrictionendonucleases (REs) consist of three different subunits: methylase (M), 

restriction (R) and specificity (S) encoded by the hsdM, -R and -S genes, where hsd 

refers to Host Specificity for DNA. Together, they form an intriguing, 

multifunctional complex which can either restrict or modify DNA. Here, the mode 

of action of the complex is dictated by the methylation state of the recognition 

sequence. 
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A fully methylated site results in no action being taken and in enzyme dissociation; 

hemi-methylated target sequences direct the enzyme into a protective methylation 

mode producing fully methylated DNA, while unmethylated DNA shifts the 

enzyme into a destructive (and protective) restriction mode. It is in this protective 

mode that type I enzymes restrict foreign DNA and thereby maintain the integrity 

of the host genome. 
 
Process of RFLP:  
Restriction Fragment Length Polymorphism (RFLP) is a difference in 

homologous DNAsequences that can be detected by the presence of fragments of 

different lengths after digestion of the DNA (genomic DNA or PCR product or 

plasmid) samples in question with specific restriction endonucleases.Most RFLP 

markers are co-dominant (both alleles in heterozygous sample will be detected) 

and highly locus-specific. 

The RFLP probes are frequently used in genome mapping and in variation analysis 

(genotyping, forensics, paternity tests, hereditary disease diagnostics, etc.). 

 

PCR-RFLP  
Isolation of sufficient DNA for RFLP analysis is time consuming and labor 

intensive. However, PCR can be used to amplify very small amounts of DNA, 

usually in 2-3 hours, to the levels required for RFLP analysis. Therefore, more 

samples can be analyzed in a shorter time. An alternative name for the technique is 

Cleaved Amplified Polymorphic Sequence (CAPS) assay. 

Variation Analysis  
Genetic variation or polymorphism: is the regular and simultaneous occurrence, 

in a singleinterbreeding population of two or more discontinuous genotypes. The 

concept includes differences in genotypes ranging in size from a single nucleotide 

site (Single Nucleotide Polymorphism) to large nucleotide sequences visible at a 

chromosomal level. 

Genotype: is the genetic constitution of the individual, comprising the ALLELES 

present ateach GENETIC LOCUS. 

Genotyping: is the method used to determine individuals' specific ALLELES or 

SNPS (singlenucleotide polymorphisms). 

Basic classes of DNA variation  
o Insertion-Deletion Length Polymorphism (INDEL) 

 
 

o Single Nucleotide Polymorphism (SNP) 
  

o Simple Sequence Repeat (SSR) Length Polymorphism (Mini- and Micro- Sattellites) 
 

http://www.ncbi.nlm.nih.gov/projects/genome/probe/doc/Glossary.shtml#re
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Single nucleotide polymorphism  
A single nucleotide variation in a genetic sequence, that occurs at appreciable 

frequency in the population. 

 

 
 
 
 
 
 

 

 

Importance of genetic variation analysis  
o early diagnosis, prevention and treatment of human diseases 

 

o systematics and taxonomy 
 

o population, quantitative, and evolutionary genetics 
 

o plant and animal breeding 
 

o identifying individuals and populations (paternity and forensic analysis) 
 

 

SNP genotyping technologies 

Primer Extension 

 
 Common Primer Extension (CPE) reaction, a method for SNP genotyping that 

involves annealing a primer to 3' end of DNA fragment adjacent to a SNP site 
followed by its extension using dideoxynucleotide terminators (ddNTPs) to 
preven further incorporation of nucleotides. The identity of the extended base 
is determined either by fluorescence or mass to reveal SNP genotype. 

 

 

 Allele-Specific Primer Extension (ASPE) uses extension of allele-specific 
primers with PCR amplified template, and the extended products are analyzed 
for fluorescence to determine SNP genotype. 

 

 

Hybridization 
 

 Gene Chip® array (Affymetrix, CA) 
 

 TaqMan® genotyping assay (Applied Biosytems) combines hybridization 
and 5' nuclease activity of polymerase coupled with fluorescence detection. 

 

 
Ligation 
 

 Molecular Invertion Probes (MIP) 
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Enzymatic cleavage  
 Restriction Fragment Length Polymorphism (RFLP) 

 
 

 Invader® assay (Third Wave,TM Technologies, WI) 
 

 
Selection of Restriction Enzymes: 

Step 1  
Identify restriction enzyme sites on your vector by looking at a restriction map. 

The restriction map will tell you which enzymes will cut your vector, and where. 

Step 2  
Choose a restriction enzyme that also has a site present on your gene insert, by 

looking at the sequence of the insert. Ensure the restriction site is at a position on 

your insert that is outside the gene of interest, so you do not lose any part of the 

gene. 

Step 3  
Ensure that there are no duplicates of the restriction site anywhere in your gene 

insert or vector. This will cause multiple cuts in your DNA and give you 

misleading data. 

Step 4  
Try to choose restriction enzymes that cut with sticky ends, rather than blunt ends. 

Sticky ends occur when the enzyme cuts double stranded DNA in a staggered 

manner, leaving a single stranded overhang that facilitates attachment with an 

insert cut in the opposite manner. Blunt ends occur when the double-stranded DNA 

is cut in a smooth manner, and these are more difficult to attach. 

Step 5  
Choose a different restriction enzyme for both ends of your insert to ensure it is 

inserted into the vector in the proper orientation and to ensure the vector does not 

re-attach to itself. 

Step 6  
Try to choose two restriction enzymes which function well in the same buffer 

system and temperature. If this is not possible, run each digestion separately. 

 

Note: A similar chemistry is applied for SNP genotyping with certain variations. 

The variations dependon the nature and type of change which is supposed to be 

recognized by the restriction enzyme of choice 
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Protocol: 

 

Serial no Constituents Stock 
concentration 

Volume (µl) 
1X reaction 

Final 
concentration 

1 MilliQ - 21.5 - 

2 Buffer 10X 3 1X 

3 RE (Hha I) 10U/µl 0.5 1U/µ 

4 PCR product - 5 Depending on 
Amplification 

 Total volume  30  
 
 
Prepare 0.2ml PCR tubes properly labelled for the number of samples whose 

RFLP is to be performed. 

 
 

In a 0.5ml tube prepare the above mentioned master mix except the PCR 

product. The master mixis for a single tube. 

 
 

Calculate the volume of the master mix according to the number of tubes 

considered for RFLP. 

 
 

Dispense the 1X volume of the master mix in each of the tube with PCR product 

selected for RFLP. 

 
 

Mix the tube by gently spinning in a table spinner. 

 
 

Incubate the tubes in water at the activation temperature suggested in the 

Restriction enzyme manual provided by the company. 
 

 

On completing the incubation for activation temperature, incubate the tubes at the 

denaturation temperature suggested by the manual for Restriction Enzyme 

provided by the company. 

 
 

Load the entire sample in the tubes on 1% agarose gel to observe the 

digestion. 
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V. Primer Designing – Concepts to Expertise 
 
 
General Concepts for PCR Primer Design  
PCR is a technology born of the modern molecular biology era. The enzyme used 

for PCR, Taq DNA polymerase, supplied with the 10x buffer, is purchased as a 

cloned product, and the nucleoside triphosphates are ultrapure, buffered, and 

available at a convenient concentration. Yet, with all of these commercially 

available starting materials, PCR still fails, particularly for the novice. Assuming 

that all of the reagents have been added in the proper concentrations, two critical 

PCR components are left to the researcher. 

 
The first is the nucleic acid template, which should be of sufficient quality and 

contain no inhibitors of Taq DNA polymerase (although when it comes to template 

purity, PCR is more permissive than many other molecular biology techniques). 

 

The second is the selection of the oligonucleotide primers. This process is often 

critical for the overall success of a PCR experiment, for without a functional 

primer set, there will be no PCR product. Although the selection of a single primer 

set may be trivial, the construction of primer sets for applications such as multiplex 

or nested PCR becomes more challenging. 

 
The manual selection of optimal PCR oligonucleotide primer sets can be quite 

tedious and thus lends itself very naturally to computer analysis. The primary 

factors that affect the function of the oligonucleotides their melting temperatures as 

well as possible homology among primers are well defined and straightforward 

tasks that are easily encoded in computer software. 

 

Once the computer has provided a small number of candidate primer sets, the task 

of selection can be (and still is) performed manually. In this approach, the 

researcher is taking advantage of the raw speed of computer calculations, trying all 

possible permutations of a primer's placement, length, and relation to the other 

primers that meet conditions specified by the user. From the thousands of 

combinations tested by the computer, a software program can present just those 

that are suitable for the needs of the experiment. 

 

Thus, the overall "quality" (as defined by the user in program parameters) of the 
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primers selected is almost guaranteed to be better than the handful chosen and 

hand-tested by the research without computer assistance. 

 

As with any tool, understanding its function will make the end product more 

useful. A wide range of programs have been written to perform primer selection, 

varying significantly in selection criteria, comprehensiveness, interactive design, 

and user-friendliness. There are also commercially available specialty primer 

design software programs that offer enhanced user interfaces, additional features, 

and updated selection criteria, as well as primer design options that have been 

added to larger, more general software packages. 

 
Although most people would agree that application of analytic computer software 

to a well-defined problem is a smart thing to do, not all researchers are convinced 

that PCR primerselection is a nontrivial task or that the selection rules that make a 

primer amplify efficiently are even well defined. Even though many of the rules 

discussed have been fine-tuned by collective empirical wisdom, most are based on 

firm theoretical ground, if not common sense. 

 
The purpose of this chapter is to explain basic rules of oligonucleotide primer 

design. With this understanding of primer selection criteria, the information 

deduced by primer design software can be rationally interpreted and manipulated 

to fit your experimental needs. 

 

PARAMETERS USED IN BASIC PCR PRIMER DESIGN  
Primer design is aimed at obtaining a balance between two goals: specificity and 

efficiency of amplification. Specificity is defined as the frequency with which a 

mispriming event occurs. Primers with mediocre to poor specificity tend to 

produce PCR products with extra unrelated and undesirable amplicons as 

visualized on an ethidium bromide-stained agarose gel. Efficiency is defined as 

how close a primer pair is able to amplify a product to the theoretical optimum of a 

twofold increase of product for each PCR cycle. 

 

Given a target DNA sequence, analysis software attempts to strike a balance 

between these two goals by using preselected default values for each of the primer 

design variables. These variables, listed below, have predictable effects on the 

specificity and efficiency of amplification. Depending on the experimental 
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requirements, these "primer search parameters" can be adjusted to override the 

default values that are meant to be effective for only general PCR applications. 

For example, in medical diagnostic PCR applications, search parameters and 

reaction conditions would be adjusted to increase specificity at the cost of some 

efficiency, because avoiding false-positive results is a higher priority in this case 

than producing large quantities of amplified product. By carefully considering the 

following parameters when using primer design software, more effective selection 

of primers will be achieved. 

 

Primer Length  
The specificity is generally controlled by the length of the primer and the annealing 

temperature of the PCR reaction. Oligonucleotides between 18 and 24 bases tend 

to be very sequence specific if the annealing temperature of the PCR reaction is set 

within a few degrees of the primer Tm (defined as the dissociation temperature of 

the primer/template duplex). These types of oligonucleotides work very well for 

standard PCR of defined targets that do not have any sequence variation. 

The longer the primer, the smaller the fraction of primed templates there will be in 

the annealing step of the amplification. In exponential amplification, even a small 

inefficiency at each annealing step will propagate to produce a significant decrease 

in amplified product. In summary, to optimize PCR, the utilization of primers of a 

minimal length that ensures melting temperatures of 54°C or higher will provide 

the best chance for maintenance of specificity and efficiency. 

Short oligonucleotides of 15 bases or less are useful only for a limited amount of 

PCR protocols such as the use of arbitrary or random short primers in mapping 

simple genomesand in the subtraction library protocol described by certain 

research references. Depending on the genome size of the organism, there is a 

minimum primer length. In general, it is best to build in a margin of specificity for 

safety. For each additional nucleotide, a primer becomes four times more specific; 

thus, the minimum primer length used in most applications is 18 nucleotides. 

Clearly, if purified cDNA is being used, or genomic DNA is not present, the length 

could be reduced because the risk of nonspecific primer/template interactions will 

be greatly reduced. 

 

Yet, it is generally a good idea to design primers such that the synthesized 

oligonucleotides can be used in a variety of experimental conditions (18- to 24-

mers), and the small marginal cost of oligonucleotides with four to five additional 
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bases makes it worth the expense. 

 
The upper limit on primer length is somewhat less critical and has more to do with 

reaction efficiency. For entropic reasons, the shorter the primer, the more quickly it 

will anneal to target DNA and form a stable double-stranded template to which 

DNA polymerase can bind. In general, oligonucleotide primers 28--35 bases long 

are necessary when amplifying sequences where a degree of heterogeneity is 

expected. This has proved to be generally useful in two types of applications: 

 

1. In amplifying sequences encoding closely related molecules, such as 

isoforms of a protein or family of proteins within a species, as well as in 

the cloning of the homologous gene from a different species, and 

 

2. In amplifying the sequences of viruses such as HIV-1, where the 

possibility of having a set of primers with perfect complementary to all the 

templates (in this example, all HIV-1 isolates) is not expected.  

 

In both cases, one first uses primer design software to compare all available related 

sequences and, in such a manner, determines the DNA region with the least 

amount of sequence variability. These regions serve as starting places for selecting 

the primers. In some instances, the researcher already knows the function of the 

encoded protein and the domains essential to performing that function. In these 

cases, comparing available sequences in the regions critical for the functional 

activity of the related proteins within the family will aid in defining the sequences 

for designing new primers. 

 
Examples include the PCR cloning of an enzyme or receptor with a similar 

structure and function from a related species using the available structural data. 

With the amino acid sequence information and the help of codon usage tables for 

different species, both primers, and at least one of them, could be designed around 

the "conserved sequence." When selecting primers to amplify DNA from a 

different species, sequences at the 5'- or 3'-untranslated regions of the mRNA 

should be avoided because they may not necessarily have high degree of 

homology. 

 

The placement of the 3' end of the primer is critical for a successful PCR reaction. 

If a conserved amino acid can be defined, the first 2 bases of the codon, or 3 bases 
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in the case of an amino acid encoded by a single codon (methionine and 

tryptophan), can serve as the 3' end. Perfect base-pairing between the 3' end of the 

primer and the template is optimal forobtaining good results; minimal mismatch 

should exist within the last 5 to 6 nucleotides at the 3' end of the primer. 

 
Attempts to compensate for the mismatches between the 3' end of the primer and 

the template by lowering the annealing temperature of the reactions do not improve 

the results, and failure of the reaction is almost guaranteed. With this concept in 

mind, one should evaluate all possible strategies in the design of primers when the 

nucleotide sequence of the template to be amplified is not known with certainty. 

Cases like the one described above are routinely encountered when the researcher 

wishes to amplify a cDNA using information from a partial protein sequence. 
 
Several approaches that include the use of degenerate oligonucleotide primers 

covering all possible combinations for the bases at the 3' end of the primer in the 

pool, as well as the use of inosine to replace the base corresponding to the third or 

variable position of certain amino acid condons, have been successful for cDNA 

cloning and for detection of sequences with possible variations. Much of this type 

of PCR study is empirical, and different primers may have to be synthesized to 

obtain the desired match. 
 
Longer primers could also arise when extra sequence information, such as a T7 

RNA polymerase-binding site, restriction sites, or GC clamp, is added to primers. 

In general, the addition of unrelated sequences at the 5' end of the primer does not 

alter the annealing of the sequence-specific portion of the primer. In some cases, 

when a significant number of bases that do not match the template sequence are 

added to the primer, four to five cycles of amplification can be performed at a 

lower annealing temperature followed by the rest of the cycles at the annealing 

temperature, calculated with the assumption that the sequence at the 5' end of the 

primer is already incorporated into the template. 
 
Additional bases at the 5' end of the primers are frequently added when the 

researcher needs to clone the PCR product. In these cases, the restriction enzyme 

sites of choice will be the ones that do not cut within the DNA at sites other than 

the primer. 
 
To ensure sub cloning of the whole amplified fragment of unknown sequence as a 
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single piece, addition of sites for enzymes that recognize 6 bases or the addition of 

partially overlapping recognition sites for different enzymes is recommended. An 

important consideration when adding restriction sites to a primer is the fact that 

most enzymes require two or three nonspecific extra bases 5' to their recognition 

sequence to cut efficiently, adding to the length of the non template- specific 

portion of the primer. 
 
Another drawback of long primer sequences is in the calculation of an accurate 

melting temperature necessary to establish the annealing temperature at which the 

PCR reaction is to be performed. 
 

For primers shorter than 20 bases, an estimate of Tm can be calculated as 
 

Tm = 4 (G + C) + 2 (A + T) 
 
Whereas for longer primers the Tm requires the nearest- neighbour calculation, 

which takes into account thermodynamic parameters and is employed by most of 

the available computer programs for the design of PCR primers. 

 

The Terminal Nucleotide in the PCR Primer 
 
Kwok and colleagues have shown that the 3'-terminal position in the primer is 

essential for controlling mispriming. For certain applications as described above, 

this chance of mispriming is useful. The other issue concerning the 3' ends of the 

PCR primers is the prevention of homologies within a primer pair. Care has to be 

taken that the primers are not complementary to each other, particularly at their 3' 

ends. Complementarity between primers leads to the undesirable primer-dimer 

phenomena in which the PCR product obtained is the result of the amplification of 

the primers themselves. 
 
This sets up a competitive PCR situation between the primer-dimer product and the 

native template and is detrimental to the success of the amplification. In cases 

when multiple primer pairs are added in the same reaction (multiplex PCR), it is 

very important to check for possible complementarity of all the primers added in 

the reaction. Generally, the computer programs do not allow primer pairs with 3'-

end homologies and, in conjunction with the hot start technique, the chances of 

formation of primer-dimer products are greatly reduced. 
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Reasonable GC Content and Tm 
 
PCR primers should maintain a reasonable GC content. Oligonucleotides 20 bases 

long with a 50% G + C content generally have Tm values in the range of 56-62~ 

this provides a sufficient thermal window for efficient annealing. Within a primer 

pair, the GC content and T m should be well matched. Poorly matched primer pairs 

can be less efficient and specific because loss of specificity arises with a lower T m 

and the primer with the higher T m has a greater chance of mispriming under these 

conditions. If too high a temperature is used, the primer of the pair with the lower 

T m may not function at all. This matching of GC content and T m is critical when 

selecting a new pair of primers from a list of already synthesized oligonucleotides 

within a sequence of interest for a new application. For this reason we advocate the 

adoption of standardized criteria for primer selection within a laboratory. By 

planning ahead, it is easier to mix and match selected primers, as they will all have 

similar physical characteristics. 

 

PCR Product Length and Placement within the Target Sequence  
All of the computer programs provide a place for selecting a range for the length of 

the PCR product. In general, the length of the PCR product has an impact on the 

efficiency of amplification. The length of a PCR product for a specific application 

is dependent in part on the template material. Clinical specimens prepared from 

fixed tissue samples tend to yield DNA that does not support the amplification of 

large products. From pure plasmid or high-molecular-weight DNA, it is relatively 

straightforward to obtain products >3 kb. 

 
For the purpose of detecting a DNA sequence, generally PCR products of 150-

1000 bp are produced. The specifics of the size of the desired products often 

depend on the application. If the purpose is to develop a clinical assay to detect a 

specific DNA fragment, a small DNA amplification product of 120-300 bp may be 

optimal. The product should be specific and efficient to produce while containing 

enough information for use in a capture probe hybridization assay. Products in this 

size range can be produced using the two-step amplification cycling method, 

thereby shortening the length of the amplification procedure. 

 

Other PCR approaches have different optimal product lengths. For example, for 

the purpose of monitoring gene expression by quantitative RNA PCR, the product 
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must be large enough that a competitive template can be constructed and both can 

be easily resolved on a gel. These products generally are in the 250- to 750-bp 

range. Here, the issue is maximizing the efficiency of both the reverse transcriptase 

step and the PCR. 

 
In terms of placement of the PCR primers within a cDNA sequence, two specific 

points should be kept in mind. The first is to try to keep the primers and product 

within the coding region of the mRNA. This is the unique sequence that is 

responsible for the production of the protein, unlike the 3'-noncoding region that 

will share homologies with many different mRNAs. The second point is to try to 

place the primers on different exons. In so doing, the RNA-specific PCR product 

will be different in size from one arising from contaminating DNA. 

 
If the purpose of the PCR is to clone a specific region of a gene or cDNA, then the 

size of the PCR product is preselected by the application. Here, the computer 

program can provide information about selected primer sets that flank the desired 

area. In some instances, when the complete sequence is required for further 

experiments and the PCR product to be obtained is above the ideal length, or the 

template is not of the best quality, overlapping PCR fragments can be amplified by 

designing primers flanking unique restriction sites in the template sequence. The 

production of a fragment containing the entire sequence will then be obtained by 

cutting and pasting the amplified pieces. 

 
When approaching this kind of application it is important beforehand to think 

about the ideal method for cloning the PCR products and how the clone will be 

used in the future. For example, if one wishes to utilize restriction endonuclease 

sites at the end of primers as described above, it is important to be sure that these 

enzymes do not cut within the amplified region. Software programs can provide 

this information. 

 

A Simple Rule for Non-computer-based Selection  
Occasionally, the PCR primers must be selected from very much defined regions at 

the 3' and 5' ends of a specific sequence. A simple method of primer design is to 

choose regions that are deficient in a single nucleotide. By selecting primers in this 

way, the chance of extensive primer-primer homology is reduced. Here, again, care 

must be taken to have a balanced primer pair in terms of length and base 
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composition so that the T m of the primers are well matched. 
 
Utilizing primer design software  
It is important to stress that the primer selection parameters described here are 

general and are not necessarily implemented in the same manner among the 

different primer selection software. Thus, two programs using slightly different 

selection algorithms will rarely, if ever, select the exact same primers, even if the 

basic parameters are equivalently set. These discrepancies are attributable to 

differences in the calculation methods and the order in which the selection criteria 

are applied. For example, calculating the temperature of primer/template annealing 

can be performed in one of several ways. 

 
The original formula of Suggs and co-workers,  

Tm=2°C X (A+T) + 4°C X (G+C), 

 

is popular for its simplicity and roughly accurate prediction of oligonucleotide Tm. 

More recently, Rhylick et.al. Implemented Tm prediction based on nearest-

neighbour thermodynamic parameters, which appear to be slightly more accurate. 

Other programs base primer annealing temperatures on formulas originally 

developed for DNA fragments > 100 nucleotides long. Thus, specifying a desired 

primer annealing temperature to be 60~ will produce different primers from the 

exact same target sequence. 

 

Further work by Rychlik and co-workers produced an empirically derived equation 

for the optimal annealing temperature of a primer pair that depends on nearest 

neighbour calculations. 

 

Wu et al. have also empirically derived an equation, based on primer length and 

GC content, to determine optimal oligonucleotide annealing temperature. These 

examples illustrate how something as basic as primer Tm calculation can vary 

among the programs. 

 

Second, different programs attack the task of primer selection very differently, 

applying selection criteria to reduce the number of possible primers that the 

program must consider while not eliminating potentially good candidates. For 

example, the program by Lowe and colleagues only considers primers that have a 
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3'-end CC, GG, CG, or GC dinucleotide, which may increase priming efficiency 

while allowing the user to specify a range of primer lengths. 

 
In contrast, the program by Rychlik and Rhoads does not impose this requirement, 

but instead checks primers of a single length specified by the user. Both of these 

approaches eliminate potentially good primers but will, in most cases, produce an 

adequate number of primers that meet all of the conditions considered to be 

important by the investigators. The researcher using the computer software should 

keep in mind that the broader the selection parameters are made, the more cases the 

computer must consider, significantly affecting the timerequired for primer 

searches. This is one reason that search parameters should be kept as narrow and 

specific as possible when clearly dictated by experimental design. More restrictive 

search parameters usually result in faster searches and produce primers of greater 

quality. 

 

In programs that attempt more difficult selection tasks, such as choosing primers 

that are highly conserved across many species, or section of degenerate primers 

from protein sequences, the basic criteria for primer section often must be relaxed 

before the software finds any suitable primer pairs. Using one of the available 

software programs in conjunction with the information presented here should result 

in the selection of a good primer set; the next task is the preparation of a good 

nucleic acid template. 
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Database Information – Necessary for Bioinformatics Data work 
 
Databases are the collection of data which is systematically organised. Biological 

databases are the data sets which contain data obtained from the biological 

experiments. The biological data is organised in specific databases depending on 

the type of data. The advances on the modern experimental techniques have 

generated large amount of data. This poses an urgent requirement to organise the 

data in biological databases. 
 
A biological database is a large, organized body of persistent data, usually 

associated with computerized software designed to update, query, and retrieve 

components of the data stored within the system. A simple database might be a 

single file containing many records, each of which includes the same set of 

information. For example, a record associated with a nucleotide sequence database 

typically contains information such as contact name; the input sequence with a 

description of the type of molecule; the scientific name of the source organism 

from which it was isolated; and, often, literature citations associated with the 

sequence. 

 

Sources of biological data: The major sources of biological include scientific 

experiments, published literature, high throughput experiment technology and 

computational analyses. The advanced scientific areas like genomics, proteomics, 

metabolomics, microarrays, gene expression and phylogenetics have contributed 

for the generation of vast amount of data. 

The biological data falls into two major categories: raw data and the processed 

data. Raw data (source data or atomic data) is data that has not been processed for 

use. A distinction is sometimes made between data and information to the effect 

that information is the end product of data processing. Raw data that has 

undergone processing is referred to as cooked data or processed data. The raw data 

has the potential to become "information," which requires selective extraction, 

organization, analysis and formatting for presentations. 
 
What are databases? 

 

o A collection of information, usually stored in an electronic format that 

can be searched by a computer.  
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o Convenient method of vast amount of information  

o Allows for proper storing, searching & retrieving of data.  

o Before analysing them we need to assemble them into central, 

shareable resources  

o Generally separated into application areas. Example: human resource 

database, sales database, accounting database etc 

Why databases?  
o Means to handle and share large volumes of biological / any data  

o Support large-scale analysis efforts  

o Make data access easy and updated. 

o Link knowledge obtained from various fields of biology and 

medicine.  

Properties of databases: 

 

 The experimental and theoretical data that is organized so that its 

contents can be easily accessed, Managed, updated and retrieved.  

 The activity of preparing a database can be divided in to: Collection 

of data in a form which can be easily accessed and making it 

available to a multi-user system  

 Most of the databases have a web-interface to search for data  
 

 Common mode to search is by Keywords  
 

 User can choose to view the data or save to your computer  
 

 Cross-references help to navigate from one database to another easily  
 
Data entry and quality control: 
 

 Scientists (teams) deposit data directly  
 

 Appointed curators add and update data  
 

 Are erroneous data removed or marked?  
 

 Type and degree of error checking  
 

 Consistency, redundancy, conflicts, updates  
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Major category of data available in the databases: 
 

 Nucleotide sequences  
 

 Protein sequences  
 

 Proteins sequence patterns or motifs  
 

 Macromolecular 3D structure  
 

 Gene expression data  
 

 Metabolic pathways  

 

 

 

Type of databases Information 

Bibliographic databases Literature 

Taxonomic databases Classification 

Nucleic acid databases DNA information 

Genomic database Gene level information 

Protein databases Protein information 

Protein families, domains and Classification of proteins and 

functional sites identifying domains 

Enzymatic / metabolic 
pathways Metabolic pathways 

 

 

Classification of databases: 
 
Biological databases are classified in different ways. They are classified based 

on the specific type of data they contain or nature of data. The classification of 

the databases based on the type of data is summarised as follows. 
 
The databases are also classified depending on the nature of the data and whether 

they have undergone any processing or not. Based on this criterion the databases 

are classified as primary, secondary and composite databases. 
 

 Primary databases: Experimental results directly into database  
 

 Secondary databases: results of analysis of primary databases  
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 Aggregate of many databases / composite 

databases: o Links to other data items  

 Combination of data o Consolidation of data  

 Primary databases Contain sequence data such as 

nucleic acid or protein  
 

 Example of primary databases include:  
 

 Protein Databases  
 

 SWISS-PROT, TREMBL, PIR  
 

 Nucleic Acid Databases  
 

 EMBL, Genbank, DDBJ  
 

 Secondary databases: Known as pattern databases. They contain results 

from the analysis of the sequences in the primary databases  
 

 Example of secondary databases include: PROSITE, Pfam, BLOCKS and 

PRINTS  

 

 Composite databases: Combine different sources of primary databases. 

Make querying and searching efficient and without the need to go to each 

of the primary databases.  
 

 Example of composite databases include: NRDB – Non-Redundant 

Database and OWL  
 

 Nucleic acid databases: The important nucleic acid databases include 
GenBank, DDBJ and EMBl.  
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Introduction to MS Word 

A Table Of Contents Manually 
 

You can type table of contents entries and use tabs to get the dotted lines, or dot 

leaders, between each entry and its page number. For a faster way to create a table 

of contents, see Create a table of contents automatically. 

1. Type the first entry. 

2. Press TAB and then type the page number for the first entry. 

3. Select the tab stop character. 

 Note    If you can’t see the tab stop character, click the Home tab, and then click 

Show/Hide in the Paragraph group. 

4. On the Page Layout tab, click the Paragraph Dialog Box launcher. 

5. Click Tabs. 

6. Under Tab stop position, type where you want the page number to be. 

 Note    To view the ruler so that you can type the right-margin location, click the 

View Ruler button at the top of the vertical scrollbar. 

7. Under Alignment, click Right. 

8. Under Leader, click the option that you want, and then click OK. 

9. Press ENTER, and then type your next entry. 

10. Press TAB, and then type the page number for your second entry. 

11. Repeat until your table of contents is complete. 

 Important    If you make changes to headings or pages in your document, you 

need to update the table of contents manually. 

Create a table of contents automatically 

The easiest way to create a table of contents is to use the built-in heading styles. 

You can also create a table of contents that is based on the custom styles that you 

have applied. Or you can assign the table of contents levels to individual text 

entries. 

Mark entries by using built-in heading styles 

1. Select the heading to which you want to apply a heading style. 

2. On the Home tab, in the Styles group, click the style that you want. 

 

http://office.microsoft.com/en-in/word-help/create-a-table-of-contents-or-update-a-table-of-contents-HP001225372.aspx#_Create_a_table
javascript:AppendPopup(this,'83158203_1')
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For example, if you selected text that you want to style as a main heading, click the 

style called Heading 1 in the Quick Style gallery. 

 If you don't see the style that you want, click the arrow to expand the Quick 

Style gallery. 

 If the style that you want does not appear in the Quick Style gallery, press 

CTRL+SHIFT+S to open the Apply Styles task pane. Under Style Name, 

click the style that you want. 

Create a table of contents 

After you mark the entries for your table of contents, you are ready to build it. 

Create a table of contents from built-in heading styles 

Use this procedure if you created a document by using heading styles. 

1. Click where you want to insert the table of contents, usually at the beginning 

of a document. 

2. On the References tab, in the Table of Contents group, click Table of 

Contents, and then click the table of contents style that you want. 

 

 
 

 Note   If you want to specify more options — for example, how many heading 

levels to show — click Insert Table of Contents to open the Table of Contents 

dialog box. To find out more about the different options, see Format the table of 

contents. 

Create a table of contents from custom styles that you applied 

Use this procedure if you already applied custom styles to your headings. You can 

choose the style settings that you want Word to use when it builds the table of 

contents. 

1. Click where you want to insert the table of contents. 

2. On the References tab, in the Table of Contents group, click Table of 

Contents, and then click Insert Table of Contents. 

3. Click Options. 

4. Under Available styles, find the style that you applied to the headings in 

your document. 

5. Under TOC level, next to the style name, type a number from 1 to 9 to 

indicate the level that you want the heading style to represent.  

http://office.microsoft.com/en-in/word-help/create-a-table-of-contents-or-update-a-table-of-contents-HP001225372.aspx#BM4
http://office.microsoft.com/en-in/word-help/create-a-table-of-contents-or-update-a-table-of-contents-HP001225372.aspx#BM4
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 Note    If you want to use only custom styles, delete the TOC level numbers for 

the built-in styles, such as Heading 1. 

6. Repeat step 4 and step 5 for each heading style that you want to include in 

the table of contents. 

7. Click OK. 

8. Choose a table of contents to fit the document type: 

 Printed document    If you are creating a document that readers will 

read on a printed page, create a table of contents in which each entry 

lists both the heading and the page number where the heading appears. 

Readers can turn to the page that they want. 

 Online document    For a document that readers will read online in 

Word, you can format the entries in the table of contents as 

hyperlinks, so that readers can go to a heading by clicking its entry in 

the table of contents. 

9. To use one of the available designs, click a design in the Formats box. 

10. Select any other table of contents options that you want. 

 

Format the table of contents 

If you already have a table of contents in your document, you can change the 

options. To do this, you need to insert a new table of contents by using the Table 

of Contents dialog box. 

1. Select the existing table of contents. 

 

 

2. On the References tab, in the Table of Contents group, click Table of 

Contents, and then click Insert Table of Contents. 

 

 
 

3. In the Table of Contents dialog box, do any of the following: 

 To change how many heading levels are displayed in the table of 

contents, enter the number that you want in the box next to Show 

levels, under General. 

 To change the overall look of your table of contents, click a different 

format in the Formats list. You can see what your choice looks like in 

the Print Preview and Web Preview areas. 
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 To change the way heading levels are displayed in the table of 

contents, click Modify. In the Style dialog box, click the level that 

you want to change, and then click Modify. In the Modify Style 

dialog box, you can change the font, the size, and the amount of 

indentation. 

 

Update the table of contents 

 

If you added or removed headings or other table of contents entries in your 

document, you can quickly update the table of contents. 

1. On the References tab, in the Table of Contents group, click Update 

Table.  

 

 
 

2. Click Update page numbers only or Update entire table. 

 

Delete a table of contents 

 

1. On the References tab, in the Table of Contents group, click Table of 

Contents. 

 

 

2. Click Remove Table of Contents. 

Create a customized hyperlink to a document, file, or Web page 

1. Select the text or picture that you want to display as the hyperlink. 

2. On the Insert tab, in the Links group, click Hyperlink. 
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You can also right-click the text or picture and then click Hyperlink on the 

shortcut menu. 

3. Do one of the following:  

 To link to an existing file or Web page, click Existing File or Web 

Page under Link to, and then type the address that you want to link to 

in the Address box. If you don't know the address for a file, click the 

arrow in the Look in list, and then navigate to the file that you want. 

 To link to a file that you haven't created yet, click Create New 

Document under Link to, type the name of the new file in the Name 

of new document box, and then, under When to edit, click Edit the 

new document later or Edit the new document now. 

 Note   To customize the ScreenTip that appears when you rest the pointer over the 

hyperlink, click ScreenTip and then type the text that you want. If you don't 

specify a tip, Word uses the path or address of the file as the tip. 

Create a hyperlink to a blank e-mail message 

1. Select the text or picture that you want to display as the hyperlink. 

2. On the Insert tab, in the Links group, click Hyperlink. 

 

You can also right-click the text or picture and then click Hyperlink on the 

shortcut menu. 

3. Under Link to, click E-mail Address.  

4. Either type the e-mail address that you want in the E-mail address box, or 

select an e-mail address in the Recently used e-mail addresses list. 

5. In the Subject box, type the subject of the e-mail message.  

 Notes  

 Some Web browsers and e-mail programs might not recognize the subject 

line. 

 To customize the ScreenTip that appears when you rest the pointer over the 

hyperlink, click ScreenTip and then type the text that you want. If you don't 

javascript:AppendPopup(this,'338184855_1')
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specify a tip, Word uses "mailto" followed by the e-mail address and the 

subject line as the tip. 

 Tip   You can also create a hyperlink to a blank e-mail message by typing the 

address in the document. For example, type someone@example.com, and Word 

creates the hyperlink for you, unless you turned off automatic formatting of 

hyperlinks. 

Create a hyperlink to a specific location 

To link to a location in the same document or in a different document, you must 

mark the hyperlink location or destination and then add the link to it. 

Mark the hyperlink location 

You can mark the hyperlink location by inserting a bookmark. If you’re linking to 

a location in the same document, you can also use a heading style to mark a 

location. 

Insert a bookmark 

In the document that you want to link to, do the following: 

1. Select the text or item to which you want to assign a bookmark, or click 

where you want to insert a bookmark.  

2. On the Insert tab, in the Links group, click Bookmark. 

 

3. Under Bookmark name, type a name.  

Bookmark names must begin with a letter and can contain numbers. You can't 

include spaces in a bookmark name. However, you can use the underscore 

character to separate words — for example, First_heading. 

4. Click Add. 

5.  

javascript:AppendPopup(this,'523738815_2')
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Apply a heading style 

When you’re linking to a location in the same document, you can apply one of the 

built-in heading styles in Word to the text at the location that you want to go to. In 

the current document, do the following: 

1. Select the text to which you want to apply a heading style. 

2. On the Home tab, in the Styles group, click the style that you want. 

 

For example, if you selected text that you want to style as a main heading, click the 

style called Heading 1 in the Quick Styles gallery. 

Add a link to a specific location in the current document 

1. Select the text or object that you want to display as the hyperlink. 

2. Right-click and then click Hyperlink on the shortcut menu. 

3. Under Link to, click Place in This Document. 

4. In the list, select the bookmark or heading or that you want to link to. 

 Note   To customize the ScreenTip that appears when you rest the pointer over the 

hyperlink, click ScreenTip, and then type the text that you want. If you don't 

specify a tip, Word uses "Current document" as the tip for links to headings. For 

links to bookmarks, Word uses the bookmark name. 

Add a link to a specific location in another document 

1. Select the text or object that you want to display as the hyperlink. 

2. Right-click and then click Hyperlink on the shortcut menu. 

3. Under Link to, click Existing File or Web Page. 

4. Click the file that you want to link to, and then click Bookmark. 

5. In the list, select the bookmark that you want to link to. 

 Note   To customize the ScreenTip that appears when you rest the pointer over the 

hyperlink, click ScreenTip and then type the text that you want. If you don't 

specify a tip, Word uses "Current document" as the tip for links to headings. For 

links to bookmarks, Word uses the bookmark name. 



81 
 

Quickly create a hyperlink to another file 

You can create a hyperlink quickly without having to use the Insert Hyperlink 

dialog box by dragging selected text or pictures from a Word document. 

 Important   The text that you copy must come from a file that has already been 

saved. 

 Note   You cannot drag drawing objects, such as Shapes, to create hyperlinks. To 

create a hyperlink for a drawing object, select the object, right-click, and then click 

Hyperlink on the shortcut menu. 

Create a hyperlink by dragging content from another Word document 

1. Save the file that you want to link to. This is the destination document. 

2. Open the document where you want to add a hyperlink. 

3. Open the destination document and select the text, graphic, or other item you 

want to go to. 

For example, you might want to select the first few words of a section of a 

document that you want to link to. 

4. Right-click the selected item, drag it to the task bar and rest over the icon of 

the document to which you want to add a hyperlink. 

5. Release the right mouse button where you want the hyperlink to appear on 

the page, and then click Create Hyperlink Here . 

 Note   The text, graphic, or other item that you selected is the link to the 

destination document.  

Turn on or off automatic hyperlinks 

You can turn automatic links on or off. If you’re using automatic links and Word is 

displaying only part of the link path, you can change the settings to show the full 

path of hyperlink. 

Turn on automatic hyperlinks 

1. Click the File tab. 

2. Click Options. 

3. Click Proofing. 

4. Click AutoCorrect Options, and then click the AutoFormat As You Type 

tab. 

5. Select the Internet and network paths with hyperlinks check box. 

Show the full path of hyperlinks 

1. Click the File tab. 
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2. Click Options. 

3. Click Advanced. 

4. Under General, click Web Options, and then click the File tab. 

5. Clear the Update links on save check box. 

Turn off automatic hyperlinks  

1. Click the File tab. 

2. Click Options. 

3. Click Proofing. 

4. Click AutoCorrect Options, and then click the AutoFormat As You Type 

tab. 

5. Clear the Internet and network paths with hyperlinks check box. 

Remove a hyperlink 

Do one of the following: 

 Press CTRL+Z. You must press CTRL+Z immediately after you type the 

address, or URL, to delete a hyperlink from a typed URL. 

 Note    If you press CTRL+Z a second time, the typed URL is deleted. 

 Right-click the hyperlink, click Edit Hyperlink on the shortcut menu, and 

then click Remove Link. 

Click to follow a link 

By default, Word requires you to press CTRL and click to go to the destination of a 

hyperlink. This prevents you from suddenly going to a destination when you’re 

trying to edit a document. 

To change this setting so that you can click a link without having to press CTRL, 

do the following: 

1. Click the File tab. 

2. Click Options. 

3. Click Advanced. 

4. Under Editing Options, clear the Use CTRL + Click to follow hyperlink 

check box. 
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Introduction to MS Excel  

Evolution of the Spreadsheet : 

The first electronic spreadsheet, known as VisiCalc, was developed by Dan 

Bricklin and Bob Frankston. While an MBA student at Harvard, Dan used this 

spreadsheet concept to crunch numbers in a case study around Pepsi-Cola's 

marketing campaigns. This software soon became one of two "killer apps", (along 

with word processing) that influenced personal computer growth. Today the 

electronic spreadsheet is used in numerous fields for asking "what if" questions and 

providing immediate answers by using formulas to perform calculations. To read 

more about the development of electronic spreadsheets, 

Workbook: 

As spreadsheets became larger, they became more difficult to manage. The concept 

of a workbook was developed to manage this collection of spreadsheets. In this 

lesson, you have opened a sheet within a workbook in Excel. The default number 

of sheets included in a workbook is three but you can add as many sheets as 

needed depending on the memory available on your computer. 

Lesson 1: Electronic Spreadsheet  

Excel is an electronic spreadsheet. A spreadsheet program can store, manipulate, 

and create graphical representations of data. It can be integrated into the 

curriculum in lessons that have information that can be quantified. 

Excel spreadsheet example - An empty spreadsheet with a task pane opened. 

Remember that a task pane has common tasks readily displayed.   
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Activity 1: Opening Excel  

In this activity you will be opening the spreadsheet program Microsoft Excel and 

entering text into an Excel document. 

1. Turn on your computer. 

2. Click on the Start button then click on All Programs> 

Microsoft Office> Microsoft Excel . (For Macs go to the 

Finder Menu and click on Go then click on Applications. In the Application 

window click on the link to Microsoft Office. In the Microsoft Office window 
click Excel. ) 

  

Elements of importance: 

 Columns 

 Rows 

 Cells  

Activity 2: Downloading, Saving and Opening an Existing File  

This activity will use a file entitled demoXP.xls that has already been created and 

saved on the Edutech site. To download and save this file:  
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1. Right click here  

2. Select Save Target As... (In FireFox you will select Save Link As.) 

A Save As dialogue box will open allowing you to change the file name and 

the location where the file is saved. You should include your initials in the 

file name and choose a folder location where your course files are stored on 

the hard drive. In previous tutorials you should have created a course work 

folder and a CEP 810 folder. Save this file in your CEP 810 folder.  

3. Click on Save and the demoXP.xls spreadsheet will be saved to your folder. 

To Open the File: 

1. In the main Excel menu bar click once on the File menu, scroll down and 

click on Open. ( File> Open ) 

2. Navigate through your folder directory and click on the demoXP file. (You 

should have added your initials to the file name.)  

 

Lesson 2: Spreadsheet Window - Elements Common with Microsoft Word  

In this next lesson you will learn about the main elements of the Excel window. 

The elements shown below are similar to elements found in Microsoft Word.  

 

Title Bar  
 

The Title Bar lists the name of the software program you 

have open and then lists the name of the specific document 

you are viewing. In this case, Microsoft Excel is open with 

http://edutech.msu.edu/online/Excel/demoXP.xls
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the document name of Book1  

 

showing. Microsoft and other software use a default naming 

system of Book1, Book2 etc., to automatically name files 

until you change the name to a descriptive word meaningful 

to you. Because you have opened the demoXP file, your 

title bar should show the name of that document.  
 

Menu Bar   
The terms (words) in the Menu Bar each represent a 

different submenu. To view the menu- mouse over the word 

in the menu bar and a pull down menu appears. The options 

in the pull down menu represent functions that are relevant 

to the term in the menu bar. If you see a downward pointing 

double arrow then you are viewing only the most frequently 

used options. Click on the double arrow to show all 

available options.   
 

Standard 

Toolbar  
 

The Standard Toolbar has icons for frequently used items. 

This bar will change to reflect recently used icons as you 

use the software. You can move any toolbar to other 

locations in the spreadsheet by clicking and holding on the 

four vertical dots on the left side of the toolbar.  

The separator line, highlighted below, provides additional 

handles for moving the toolbar within the page. 

 
 

Formatting 

Toolbar  
 

The Formatting Toolbar allows you to quickly make 

formatting changes to text and cells. Specifically, these 

buttons will allow you to make changes to the appearance 

of your document. The icons in this bar will vary as you use 

the program. If the icon you want to use does not appear in 

this menu, click on the toolbar options icon at the far right 

of this bar to select the option you would want to add.  
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Scroll bar 

 
The Scroll Bar allows the viewer to view different parts of 

the spreadsheet that may not be viewable because of the 

screen size. You can move the vertical scroll bar up or down 

and the horizontal scroll bar left or right. 
 

Status Bar   
The left side of the Status Bar shows the possible states 

you have for each cell; Ready, Enter, or Edit. The other 

cells show the result of formulas used in selected cells.  
 

 Lesson 3: Spreadsheet Window - Unique Elements  

These elements are unique to Excel and other electronic spreadsheets.  

 

Formula Bar  

 
The Formula Bar shows the selected cell on the left. The 

fx box on the right provides an area for entering data or 

formulas into the cell.  
 

Column & 

Row Header  

 
In the Column & Row Header, each column is labeled 

with a letter and each row is associated with a number. 

The columns, which go from the top of the page to the 

bottom, just like a column on a building, begin with A 

and go through the alphabet repeatedly with a letter 

sequence of AA, AB, ...IV until 256 columns have been 

identified. The rows are numbered from 1 - 65,536.  
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Column 

 
Each Column can be selected by clicking on the 

corresponding letter on the spreadsheet. Numerous 

columns can be selected by clicking and dragging the 

cursor over the letters.  
 

Row 

 
In turn, each Row can be selected by clicking on the 

corresponding number on the spreadsheet. Numerous 

rows can be selected by clicking and dragging the cursor 

over the numbers. A hint: When selecting many rows, 

start from the row furthest from the beginning and drag 

the mouse upward to control the "runaway mouse".  
 

Cell 

 
A Cell is the union of a column and row. The wide black 

line around the cell means that the cell has been selected 

using a single left click. A square box (AutoFill handle) 

appears on the lower right edge. We will talk more about 

the AutoFill in another lesson.  
 

Tabs  
The Sheet Tabs are located at the bottom of the 

spreadsheet and serve as navigation tools for the 

workbook. A sheet is a single spreadsheet. A workbook 

(excel file) may have multiple sheets. Three sheets are 

provided when you open the workbook but more can be 
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added by selecting Insert > Worksheet from the standard 

toolbar. The current worksheet will have the white 

background and extra sheets will have the gray tab. To 

change from one worksheet to another, just click on the 

worksheet tab you want to view. Sheet names can be 

easily changed by double clicking on the text "Sheet1" 

and typing the new name when the original letters are 

highlighted with a black background. 

The arrows serve as navigation tools also. The vertical 

line with the left pointing arrow will take you to the 

leftmost sheet in the workbook. Correspondingly, the 

right pointing arrow with the horizontal line brings up 

the rightmost worksheet. The individual arrows move to 

the previous or next worksheet.  
 

Cursor 

The wide white Plus Symbol serves as a 

selecting cursor. With the cursor in this state, you can 

select a cell using a left click. The cell then becomes 

highlighted with the wide black rectangle 

.  

The blinking I Beam or Insertion Point is visible when 

the cell is in the Ready state and you have either double 

clicked into the cell or have put data into the cell. Even 

though the I Beam is common in other programs, the 

difference is that an extra action (double clicking or 

typing) is necessary for this to appear. 
 

Nomenclature 

 
The cell is named by listing the column letter first 

followed by the row number. In this example; C1 refers 

to the cell in the third column of the first row. Remember 

that the formula bar displays the name of the highlighted 

cell. If more than one cell is selected, the initial cell will 

be displayed followed by a colon and then the name of the 
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last cell (e.g., A1:D1).  
 

Entry Bar  

 
There are two ways to activate the enter or edit mode of 

the cell. You can double click in the cell or single click in 

the Formula Box located in the formula bar. When you 

are in this enter or edit mode, additional icons appear next 

to the entry bar. The is used to delete content in the 

cell, the is used to accept the entry you have made and 

the is used to insert a formula. Note that the black line 

surrounding the cell becomes thinner when the cell has 

been activated.  
 

Selected 

Cell(s)  

 
The wide black line surrounding the cell or selection of 

cells indicates the Selected Cells. Any changes made in 

the program will occur in those cells. Cells need not be 

adjacent to one another to be selected. This will be 

covered in later lessons.  
 

 Lesson 4: Spreadsheet Cells  

For this next lesson you will be working with the demoXP file. Please make sure 

you have the file open. You will be exploring some of the elements in an existing 

spreadsheet. Therefore for many of the steps in these activities there will be an 

accompanying explanation.  

 Remember - there are two levels when clicking in the cell - single click and 

double click 

 Activity 1: Values and Formulas  

1. Single click on cell B13 (You should see the data next to fx 

displayed like the image below.)  
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Res 

ult: Cell B13 shows the value of 24430 but the formula bar displays 

the underlying formula of one-half of the sum of cells B4 through 

B12. 
 

Adding Values  

When keying in numbers, the keypad at the right hand side of the 

desktop keyboard is helpful. Make sure the Num Lock key has been 

selected. 

After entering data in the cell, you can press Enter, TAB or any arrow 

key to move to adjacent cells. This will confirm the cell's data entry.  

Edit mode allows you to edit a cell's content. There are two ways to 

accomplish this task. 

 Double click on the cell and enter your data. 

 Click on the cell and then click on the formula bar to make 

changes. The enter, cancel and function arguments will appear 

allowing you to accept, cancel your entry or add a formula from 

the formula bar  
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To begin adding values:  

1. Click on cell C4 

2. Key in 15000. Press the Enter key or down arrow key to move 

to cell C5 Key in the remaining values in the rest of this 

column... (Remember to press the enter key or down arrow after 

each value has been entered.) 

5000 

0 

0 

160 

1500 

1000 

2500 

2500 

3. Click on File, then Save. Remember to periodically save your 

file.  

 

 Remember - if you single click on a cell to change data, you may overwrite 

current data by mistake - always double click on the cell or use the formula bar. 

Activity 2: Copying and Pasting Formulas  

In this activity you will learn how to copy a formula from one cell and 

paste it into another.  

1. Click on cell B13 

2. In the Edit menu, select Copy (You should see a dotted line 

(marquee) around cell B13.) 

3. Click on cell C13 

4. In the Edit menu, select Paste 

5. Press Enter or Esc to stop the copying of subsequent cells (You 

will no longer see the dotted line around cell B13.) The number 

13830 should appear in cell C13. 



93 
 

 

 

Notice the marquee around cell B13 reminding you that the 

content of this cell has been copied.  
 

  

 

The formula box for the row and column labels is not case sensitive so typing b4 

will result in B4 in the cell.  

Activity 3: Entering Formulas  

In this activity you will enter a formula that will add the columns B4 

and C4  

1. Double click on cell D4 and type =sum(b4:c4) 

2. Press Enter to confirm the entry  

Note: Using the sum function is more flexible than simply adding the 

two columns together since the sum function will allow you to easily 

add additional columns if you were to include a Phase 3 to the formula. 

Example: [=(B13+C13+D13)] vs. [=SUM(B13:D13)]  

When using the sum formula, the colon (:) is used to select the adjacent 

cell and the comma (,) is used to select non-adjacent cells. This 
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formula [=SUM(B4:C4,B6:C6)] would give the sum of the adjacent 

cells, B4 & C4 added to the sum of adjacent cells B6 & C6.  

Result: The value displayed in the cell D4 should be 30000 with the 

cursor in a ready position in cell D5.  
 

  

Activity 4: Copying Formulas into Multiple Locations  

In this activity you will learn how to copy and paste a formula into 

multiple cell locations. You will copy and paste the formula from D4 

into cells D5 through D13.  

1. Select cells D4 through D13 by either clicking on D4 and 

dragging down to D13 or clicking on D4 and holding down the 

Shift key and then clicking on D13. 

2. In the Edit menu, select Fill>Down 

 

Result: The formula and values should be displayed in cells D5 

through D13. Cell D13 should display the number 38260.  

Additional Information: Fill Down can be used with adjacent cells 

and does not require the use of the clipboard which uses copy and 

paste. The Fill Down action provides a Relative Reference to the cells. 
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This means that the formula will remain the same but the cell letters 

and numbers will reflect the currently selected rows and columns. If 

you want to learn more about Relative vs. Absolute Reference in cells, 

check the help menu.  
 

Alternative Method: An alternate way to complete the Fill Down is to 

select the cell to be copied, then click and hold the small black box or 

handle on the edge of the cell, then drag until you have selected all of 

the cells you want filled.  

 
 

  

Activity 5: Entering Additional Formulas 

In this activity you will learn how to add additional formulas to the 

spreadsheet. You will enter a sum formula to total Phase 1, Phase 2, 

and the Grand Total. 

1. Click on B14 and enter =sum( 

2. Drag from B4 through B13 and key in a right parenthesis and 

press Enter 
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Result: The value of 73290 should be displayed in cell B14.  
 

An alternate way to include the Sum formula is to click on cell B14 

and then click on the Sigma symbol for summation and select and drag 

through B4 through B13. If you have double clicked on the cell, you 

will need to double click on the Sigma symbol to activate the formula. 
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Now you are ready to add the totals for Phase 2 and the Grand Total.  

1. Copy and paste the formula from B14 into C14. Remember to 

click Enter or Esc to stop copying. 

2. In cell C14, enter the formula to sum column D 

The spreadsheet calculations are complete.  
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Introduction to MS PowerPoint  

Basic tasks for creating a PowerPoint  presentation 

PowerPoint presentations work like slide shows. To convey a message or a story, 

you break it down into slides. Think of each slide as a blank canvas for the 

pictures, words, and shapes that will help you build your story. 

 For a training course overview to help you create your first PowerPoint 2013 

presentation, see Create your first PowerPoint 2013 presentation.  

 For more information about the new features in PowerPoint 2013, see 

What's new in PowerPoint 2013.  

 For information about what’s new in Microsoft Office, see What’s new in 

Office 2013 

Choose a theme 

When you open PowerPoint, you’ll see some built-in themes. A theme is a slide 

design that contains matching colors, fonts, and special effects like shadows, 

reflections, and more. 

1. Choose a theme. 

2. Click Create, or pick a color variation and then click Create. 

 

 

 

http://office.microsoft.com/en-in/powerpoint-help/redir/RZ102925085.aspx?CTT=5&origin=HA102809627
http://office.microsoft.com/en-in/powerpoint-help/redir/HA102809628.aspx?CTT=5&origin=HA102809627
http://office.microsoft.com/en-in/powerpoint-help/redir/HA102830213.aspx?CTT=5&origin=HA102809627
http://office.microsoft.com/en-in/powerpoint-help/redir/HA102830213.aspx?CTT=5&origin=HA102809627
javascript:AppendPopup(this,'787177314_1')
javascript:AppendPopup(this,'534628768_2')
javascript:AppendPopup(this,'178523587_3')


99 
 

Insert a new slide 

On the Home tab, click New Slide, and pick a slide layout. 

 

 

Save your presentation 

1. On the File tab, click Save. 

2. Pick or browse to a folder.  

3. In the File name box, type a name for your presentation, and then click 

Save.  

 

 

 Tip    Save your work as you go. Hit Ctrl+S often. 
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Add text 

Click inside a text placeholder, and begin typing. 

 

Format your text 

1. Select the text. 

2. Under Drawing Tools, click Format. 

3. Do one of the following: 

 To change the color of your text, click Text Fill, and then choose a color. 

 To change the outline color of your text, click Text Outline, and then 

choose a color. 

 To apply a shadow, reflection, glow, bevel, 3-D rotation, a transform, click 

Text Effects, and then choose the effect you want.  
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Add shapes 

1. On the Insert tab, click Shapes. 

2. Pick the shape that you want, click anywhere on the slide, and then drag to 

draw the shape. 

 

Tip    To create a perfect square or circle (or constrain the dimensions of 

other shapes), press and hold Shift while you drag. 

Add pictures 

On the Insert tab, do one of the following: 

 To insert a picture that is saved on your local drive or an internal server, 

click Pictures on my PC, browse for the picture, and then click Insert. 
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 To insert a picture from Bing or the Office.com Clip Art gallery, click 

Online Pictures, and use the search box to find a picture. 

For example, type ‘Cats’ in the Office.com Clip Art search box.  

 

Here’s a sample of the cat pictures you’ll see: 

 

 Choose a picture, and then click Insert. 

Add speaker notes 

Slides are best when you don’t cram in too much information. You can put helpful 

facts and notes in the speaker notes, and refer to them as you present. 

1. To open the notes pane, at the bottom of the window, click Notes. 
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2. Click inside the Notes pane below the slide, and begin typing your notes. 

Read more: Add speaker notes to each slide in a presentation 

Print your speaker notes 

1. On the File tab, click Print. 

2. Under Printer, choose the printer that you want to print to. 

3. Under Settings, next to Full Page Slides, click the down arrow and under 

Print Layout, click Notes Pages. 

4. Click Print. 

 

Read more: Print slides with or without speaker notes. 

 

 

Give your presentation 

On the Slide Show tab, do one of the following: 

 To start the presentation at the first slide, in the Start Slide Show group, 

click From Beginning. 

http://office.microsoft.com/en-in/powerpoint-help/redir/HA102801194.aspx?CTT=5&origin=HA102809627
http://office.microsoft.com/en-in/powerpoint-help/redir/HA102809640.aspx?CTT=5&origin=HA102809627
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 If you’re not at the first slide and want to start from where you are, click 

From Current Slide. 

 If you need to present to people who are not where you are, click Present 

Online to set up a presentation on the web, and then choose one of the 

following options: 

 Present online using the Office Presentation Service  

 Start an online presentation in PowerPoint using Lync 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://office.microsoft.com/en-in/powerpoint-help/redir/HA102898423.aspx?CTT=5&origin=HA102809627
http://office.microsoft.com/en-in/powerpoint-help/redir/HA102756586.aspx?CTT=5&origin=HA102809627
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INTRODUCTION TO INTERNET AND ITS APPLICATIONS 

The Browser 

 

As you surf the Web, you will come across sites that state, "This site is best 

viewed with…" and then name a particular browser. Many will even provide 

a link to a site where you can download the specified browser.  

Sites make these recommendations because some browsers use special 

protocols, allowing site creators to offer extra features beyond the standard 

capabilities of hypertext markup language (HTML). Chief among these 

browsers are Netscape Navigator and Microsoft Internet Explorer. 

Your Internet service provider will most likely give you a choice of 

browsers (if you have a SLIP/PPP account, you may use any browser you 

wish), so try out a couple, and use the browser that best suits your needs.  

Connection Options 

 

Until recently, the two primary methods of accessing the Internet were 

through a network connection, allowing users of local area networks 

(LANs) to go online through their school or workplace systems, and dial-up 

connections through a modem and phone line. However, new connection 

options allow for greater speeds and flexibility, while keeping costs to a 

minimum.  

The following are some of the newer connection options that you might 

want to investigate:  

 Cable Internet—These systems allow your computer to connect to 

the Internet through the same cable that carries your TV signal. 

Monthly service charges are usually not much more than standard 

modem connection costs, but you have to rent or purchase a "cable 

modem." Additionally, your computer will need an Ethernet card (a 

special circuit board that allows for network connections). Not all 

cable service operators offer this service; call your local operator for 

more information. 

 Satellite connections—DirecPC (http://www.direcpc.com/) allows 

you to download Internet files via a satellite connection. This is an 

http://home.netscape.com/
http://www.microsoft.com/ie/
http://www.direcpc.com/
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efficient method for receiving large Web graphics and other items, but 

you still need a modem connection for other features. You must 

purchase the connection hardware as well as subscribe to the service. 

 Integrated Services Digital Network (ISDN)—An ISDN line is a 

type of digital phone line that can transmit data many times faster than 

a conventional modem and phone line. To learn more about ISDN, go 

to http://www.isdn.ocn.com/index.shtml 

 Wireless connections—Pagers, cellular phones and personal digital 

assistants (PDAs) now allow varying levels of Internet access, from 

notification of E-mail to limited Web connections. Many of these 

services remain in the experimental stage.  

 WebTV—Introduced in late 1996, WebTV (http://www.webtv.net/) 

provides Web and E-mail access through ordinary television sets. The 

connection is made through a custom high-speed modem. You must 

purchase a special set-top unit for your TV, plus subscribe to the 

connection service. Recently, similar systems by other manufacturers 

have appeared on the market to compete with WebTV. 

 

 

Getting Online 

 

Once you have established your Internet account, you are now ready to 

"surf" the World Wide Web from your computer. To do so, perform the 

following steps (specific instructions will vary depending on your access 

provider and software):  

1. Start up your computer, and make sure that your modem is on and 

connected to a telephone line. 

2. Open your access software.  

3. Initiate the connection. Many access software packages will display 

the status of the connection process, which generally takes between 15 

and 30 seconds.  

4. Once you have successfully connected, access and launch your Web 

browser.  

If you have successfully accessed the Web, you will see in your browser 

window the home page, or the first page that your browser is set to access. 

http://www.isdn.ocn.com/index.shtml
http://www.webtv.net/
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Often the home page is a site belonging to the manufacturer of the Web 

browser you're using. On most browsers, you can change the home page to a 

site that you'd like to access each time you begin a Web session. 

Depending on the speed of your modem and the size or complexity of the 

page you're accessing, the time necessary to completely load a page can 

range from a few seconds to several minutes. 

Finding Your Way Around 

 

Now that you've gotten on the Web, you're probably wondering how to get 

to all those great resources that you've been hearing about. Fortunately, there 

are several strategies for moving about the Web: 

 Type the URL address of a site into the entry field of your browser. 

Try it! Type the complete URL for the CenterSpan Web site below, 

then click on the "Go!" button: 

 

This is the most basic method of accessing a Web site. However, you have 

to know exactly where you want to go, and then type in the address precisely 

in order to get there. The newer browsers can compensate for some typing 

(for instance, allowing you to omit the "http://" at the beginning of a URL), 

but some URLs are too complicated for a browser to second-guess. 

If you simply want to explore and get to know the Web, any one of the 

following strategies are preferable: 

 Click on hyperlinks to move among resources; your home page 

probably has some links to interesting sites. 

 Access a jump site, which is a page consisting mainly of categorized 

hotlinks to other sites. Again, your home page may function as a jump 

site. 

 Access a Web index, which lets you access sites by typing in 

keywords.  

Jump sites contain collections of special-interest sites that the author has 

included for certain reasons. Web indexes, however, usually contain much 

http://www.centerspan.org/tutorial/glossary.htm
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more eclectic assemblies of Web resources. If you're on the Web and are not 

sure where to go, head to the nearest Web index. 

Using a Web Index  

 

To access and use a Web index, perform the following steps: 

1. While logged on to the Web, type http://www.yahoo.com/ in your 

browser's URL entry field.  

2. Press ENTER or RETURN on your keyboard.  

This will take you to Yahoo!, one of the most popular Web indexes. 

Underneath the Yahoo! logo, you will see a blank search entry form, as well 

as hotlinks of site categories. 

3. Click on one of the category topics and follow the categories until you 

reach a site that matches your interests. 

...OR... 

4. Click your mouse in the entry form. This will place a blinking cursor 

in the form.  

5. Type one or more words pertaining to information you'd like to locate 

on the Web.  

6. Click on the SEARCH button to the right of the entry form, or press 

RETURN or ENTER on your keypad.  

 

After a few seconds, Yahoo! will return with a list of hotlinks that 

match your search criteria. The more specific your criteria, the fewer 

and more specific hotlinks you will see. 

7. Scroll down the page and select the hotlink to a page that you'd like to 

explore [NOTE: Extensive search results will take up multiple pages]. 

If you would like to try searching with a Web index other than Yahoo!, 

select one of the index hotlinks listed at the bottom of each page of search 

results. When you select any one of these indexes, the keywords you entered 

for Yahoo! will remain in force, though the search results will be different 

simply because of the way that each Web index processes information. 

http://www.yahoo.com/
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Where Are the Web Indexes? 

 

In your searches, you will probably want to use various Web indexes, as 

they vary in both their content and the way in which they process search 

queries.  

The following are the addresses for a few of the more popular Web indexes:  

 Yahoo! (http://www.yahoo.com/) 

 Lycos (http://www.lycos.com/) 

 WebCrawler (http://www.webcrawler.com/)  

 InfoSeek (http://www.infoseek.com/) 

 Alta Vista (http://www.altavista.digital.com/) 

 Excite (http://www.excite.com/) 

 HotBot (http://www.hotbot.com/) 

 DejaNews [for searching USENET newsgroup posts] 

(http://www.dejanews.com/) 

 

 

Method 1 of 3: Choosing an Email Platform  

1.  

http://www.yahoo.com/
http://www.lycos.com/
http://www.webcrawler.com/
http://www.infoseek.com/
http://www.altavista.digital.com/
http://www.excite.com/
http://www.hotbot.com/
http://www.dejanews.com/
http://www.dejanews.com/
http://www.wikihow.com/Image:Send-Someone-an-Email-Step-1.jpg
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1 

Set up a Gmail account to easily access all Google platforms. Gmail is an 

extremely straightforward interface to operate and offers 15 GB of free 

storage to share between your Google Drive, Gmail, and Google+ accounts. 

This means you almost never have to delete emails and can simply archive 

them in case you ever need to recover old messages.  

o The best part about having a Google account is that it lets you access 

all of your Google platforms from any device, including Google 

Drive, which organizes text documents, photos, videos, and more, and 

allows you to share them with your contacts. 

o Gmail allows you to organize your incoming mail into as many 

folders as you want for maximum organization. 

o Gmail is very effective at blocking junkmail and also does not display 

banner ads that distract you as you construct emails. 

o Gmail allows you to send 25MB of attachments in each email. 

o Several features including RSS feeds, automatically saving drafts, 

Google search for within your mail, and linking other email accounts 

to your Gmail account are available with Gmail. 

o Gmail also allows you to communicate with contacts in real time 

using instant messaging in your inbox. You can also video chat with 

up to nine people at once and call phone numbers from the Gmail 

interface. 
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Create a Yahoo! Mail account for fast email sending without 

complicated features. Yahoo! Mail updated to a new version in 2011 that 

runs twice as fast as the old version.  

o Yahoo Mail works with Flickr and Picasa to transform links to online 

photos into embedded thumbnails and slideshows.
[1]

  

o Yahoo! Mail offers unlimited data storage, which makes it great for 

sending photos and videos with large bandwidth. 

o Unlike Gmail, however, Yahoo! allows banner ads and incorporates 

advertisements on your email interface, which can be distracting and 

annoying when trying to operate your email. 

o A "Trending Now" link appears in the upper right-hand corner of the 

Yahoo! interface, which links to trending news topics but is unrelated 

to your email. 

http://www.wikihow.com/Send-Someone-an-Email#_note-0
http://www.wikihow.com/Image:Send-Someone-an-Email-Step-2.jpg
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Make a Microsoft Outlook account to easily track shipping information 

and watch videos without leaving your email interface. Microsoft 

Outlook is the umbrella provider of Hotmail. If you are signing up for a new 

account, your address will be youremailaddress@outlook.com. Existing 

Hotmail users can retain the @hotmail.com address or make a new Outlook 

address.  

o Outlook has a limited amount of storage space, though it does have 

the same basic features that the other email providers offer. 

o Like Yahoo! Mail, Outlook automatically turns links to photos on 

Flickr or SmugMug into slideshows. It does not work with Picasa, 

however. 

o Outlook lets you watch videos linked in your email to Hulu or 

YouTube without leaving your email interface. You can also track 

USPS packages without navigating to a separate website.
[2]

  

o Outlook is also good for inter-office emailing because it includes an 

address book, calendar, task list, and virtual sticky notes. You can also 

easily create an appointment or a note and delegate work notifications 

to coworkers. 

 

 

http://www.wikihow.com/Send-Someone-an-Email#_note-1
http://www.wikihow.com/Image:Send-Someone-an-Email-Step-3.jpg
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EditMethod 2 of 3: Setting Up an Account  

 

Visit the website of the email provider of your choice. If you choose to 

use Gmail, simply visit www.gmail.com. The website for Yahoo! Mail is 

mail.yahoo.com, and Outlook is simply www.outlook.com.  

 

 

http://www.wikihow.com/index.php?title=Send-Someone-an-Email&action=edit&section=1
http://www.wikihow.com/Image:Send-Someone-an-Email-Step-4.jpg
http://www.wikihow.com/Image:Send-Someone-an-Email-Step-5.jpg
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Find the link on the homepage of your chosen provider that says "Sign 

Up" or "Create New Account." Click on the link and follow the prompts 

on the following pages. You will be asked for basic personal information 

and to create an email address.  

o Identify your audience when coming up with an email address. If you 

are going to be using your email mostly for professional purposes, 

keep it simple and use your full name or a variation of your name. 

o Don't use complicated addresses with several numbers. Doing so 

makes it harder for people to remember your address. 

o Create a password that you can remember but is not obvious or too 

simple. Combine upper and lower case words, as well as numbers, and 

make a password that someone who knows you well would not be 

able to guess. Avoid using obvious number combinations such as 

birthdays, as these are relatively easy to figure out. 

2.  

3 

Fill out the required fields and set up any other features that the 

provider prompts you to set up. If you do not want to configure a Google+ 

account, for instance, there will always be a button somewhere on the page 

that allows you to skip that step or revisit the process at a later time.  

 

 

 

http://www.wikihow.com/Image:Send-Someone-an-Email-Step-6.jpg
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Once you've created an account, you're ready to start sending and 

receiving email to your friends, family, and colleagues! 

EditMethod 3 of 3: Sending an Email  

 

Type in the URL of your email provider and log in with your username 

and password. If you forget either piece of login information, there will be 

a link underneath the login box that asks "Forgot Your 

Username/Password?" or something similar. Click the link and follow the 

steps to recover your lost information. You will most likely have to answer 

security questions to be able to reset your password.  

Become familiar with your email interface. Spend some time clicking 

around your email interface and familiarizing yourself with the different 

features and functions available to you. 
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Find the button that allows you to compose a new message and click on 

it. It will usually be somewhere in the upper left-hand corner of your inbox 

and read "Compose," "Compose New Message," or simply "New Message." 

A new screen will pop up with a blank template for composing your 

message.  

o In Gmail, you compose a new message by clicking on the red 

"Compose" button under the drop-down "Gmail" link in the upper 

left-hand corner of your inbox. 

 

Enter your recipient's email address in the address bar that reads "To." 

This will likely be the first bar on the new message template.  

o You can add multiple email addresses by separating each with a 

comma in the "To" address line. 

o You can also Cc and Bcc as many email addresses as you want by 

adding them in the appropriate bars or clicking the "Cc" and "Bcc" 

tabs in Gmail to create new address bars. Cc stands for carbon copy 

and will send an exact copy of the email you are sending to your main 

address to the addresses that you Cc. When you use the Cc function, 

all of the recipients can see the addresses of the other people you sent 

the message to. When you Bcc (blind carbon copy), only the address 

in the "To" field can see all of the email addresses that the message 

was sent to. 
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Enter a subject in the subject bar. Keep your subject line short and make 

sure that it appropriately summarizes the contents of the email you are 

sending.  

o Subject lines that use all upper case letters, misuse numbers, or 

include too many symbols may look like spam emails to your 

recipients and therefore they may not want to open them. 

o You do not have to put a subject in order to send an email. Leave the 

subject line blank if you prefer not to add one. 

 

Click your cursor in the "Body" field of the message. This box may not 

be labeled as anything but will always be the largest block of white space on 

the new message template.  

http://www.wikihow.com/Image:Send-Someone-an-Email-Step-12.jpg
http://www.wikihow.com/Image:Send-Someone-an-Email-Step-13.jpg


118 
 

 

Type in the message you would like to send to your recipient(s). Start off 

with an introductory address such as "Dear Mrs. Smith" and press "return" 

twice to create a line of space between the two pieces of text. When you are 

finished with the body of the email, press "return" twice again and sign your 

email with a parting sign-off such as "Sincerely, [Your Name]" and be sure 

to hit return between the sign-off and your name.  

o You can also add your contact information below your signature in 

order to make it easy for recipients to contact you in ways other than 

email. A common signature includes your job title, company, work or 

home address, phone number, and email. 
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Review your formatting options. Many email providers simply have a 

toolbar located between the subject line and the body of the email that 

allows you to perform simple formatting functions from choosing a font 

style, color, and size to creating a bulleted list.  

o Gmail's latest template simply has a capitalized, italicized, underlined 

"A" to the right of the "Send" button on the bottom left of the new 

message template. Click on the "A" to expand the toolbar and view 

formatting options. 

 

 

Attach a photo, video, document, or other file. Most email interfaces 

either use a paperclip symbol in order to indicate where to attach your files, 

or have a button that says "Attach Files." It is usually located at the bottom 

of the body of the email or somewhere along the toolbar between the subject 

line and the body of the email. Locate the button and click on it to attach 
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files. A pop-up window will appear that allows you to access all of the files 

on your computer. Choose the files that you want to upload and click 

"Attach," "Open," or whatever affirmative option the drop-down menu gives 

you.  

o Most email providers only allow a certain amount of data to be 

transferred per email. Gmail currently allows 25 MB per email. If all 

of the files that you want to send cannot fit in a single email, you may 

have to send multiple messages. 
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Click the "Send" button once you have finished crafting your email and 

adding any desired attachments or formatting options. The "Send" 

button is almost always located on the bottom of the message template on 

either the left or right side. Make sure your email sends before navigating 

your browser to another page.  

Tips  

 Connect your email account to your mobile device in order to receive and 

send emails remotely. 

 Save drafts of your email as you type if the email is important. Gmail 

automatically saves drafts of your message for you, but other email 

providers may not. 

 Create two separate email addresses if you want to use one for your 

professional contacts and one for friends and family. You can also create a 

separate email address for signing up for mailing lists so that your personal 

inbox is not spammed with advertisements and newsletters. 

 If you need to send an email in a hurry, try incorporating Internet shorthand 

language into your email such as "BTW" to say "by the way" or "TTYL" to 

say "talk to you later." Make sure the person receiving the email also uses 

Internet slang and will understand what you are trying to say. 

 Try to respond quickly to emails that you receive. Because most people are 

constantly connected to the Internet in some form, email users typically 

expect a response within 24-48 hours of sending an email if a response is 

required. 

 

 

 


